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I VAC 2006 * VAR 2006

1. INTRODUZIONE

11 PANORAMICA SUL SISTEMA

La nuova gamma di prodotti VAIE 2000 & stata progettata e costruita per offrire soluzioni innovative nella realizzazione di sistemi applicati ai
servizi d'emergenza. E in grado di gestire le situazioni d’allarme e consentire, in accordo alle norme vigenti (EN 54-16, 1ISO 7240-19 ed
EN 60849), un’evacuazione guidata e controllata.

Larchitettura dell’intero sistema si basa sul controller VAC 2006, unita di gestione e diagnostica particolarmente idonea sia per le grandi
che per le piccole installazioni, dove sono richieste elevati livelli di sicurezza, flessibilita e praticita d’'uso. La semplicita di collegamento (cavo
schermato CAT.5e SF/UTP) tra le varie unita di gestione, gli amplificatori e le postazioni microfoniche d’emergenza, rende efficace ed economica
la sonorizzazione di edifici complessi, consentendo I'utilizzo di apparecchi sia centralizzati che locali.

Ogni controller VAC 2006 é predisposto per la gestione di 6 linee di controllo alle quali possono essere direttamente collegate le seguenti
unita:

» Amplificatori digitali di potenza dotati di scheda di diagnostica (Serie DPU), fino ad un massimo di 16 per linea;

» Router VAR 2006 (1 per linea), in grado di gestire 6 zone con doppia linea d’uscita a 100 V (A e B);

« Sistemi integrati compatti a 6 zone (VAIE 2250, massimo 1 per linea);

» Numero massimo di zone dell’intero sistema: 216.

E possibile collegare tra loro fino ad un massimo di 6 controller VAC 2006.
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I VAC 2006 - VAR 2006

Controller VAC 2006 ed amplificatori digitali Serie DPU Controller VAC 2006 e router VAR 2006

Sistema VAIE 2000 in configurazione mista

Manuale di sistema | 2013 5 VAIE 2000 | Voice Alarm Integrated Systems



I VAC 2006 * VAR 2006

2. DESCRIZIONE GENERALE

21 CONTROLLER VAC 2006

F1.  Pulsante incassato per I'attivazione della modalita di Emergenza Manuale (EMERGENCY).

F2.  Microfono palmare con tasto di attivazione Push to Talk (P.T.T.) per annunci di emergenza a viva-voce.

F3. Pannello comandi con display grafico retroilluminato monocromatico da 128x64 pixel.

R1.  Interruttore d’accensione.

R2. Ingressi per il collegamento delle postazioni microfoniche di emergenza remote (FMD 2012, FMD 2001).

R3. Prese per il collegamento tra controller VAC 2006 (fino a 6).

R4. Ingresso per il collegamento delle postazioni microfoniche di chiamata broadcast (MBT 1106, MBT 1112).

R5. Ingresso bilanciato per microfono o sorgente esterna / Morsettiera per il collegamento del contatto di precedenza.
R6.  Ingresso per microfono esterno.

R7.  Ingresso per il collegamento di una sorgente musicale esterna.

R8. N°7 ingressi digitali monitorati per controllo da perifiche esterne.

R9. N°6 linee d'uscita per collegamento ad amplificatore Serie DPU e/o Sistemi compatti VAIE 2250 e/o Router VAR 2006.
R10. Presa di collegamento per Local Area Network con protocollo TCP/IP di rete Ethernet 10/100.

R11. N°3 uscite a rele per segnalazione verso periferiche esterne.

R12. Morsettiera per alimentazione esterna in corrente continua 24Vcc.

R13. Connessione di terra del telaio.

R14. Spina per alimentazione di rete 230Vca con fusibile integrato.

Vedi dettagli del pannello comandi a pag. 16.
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2.2
F4.
F5.
F6.
F7.
F8.
R1.

R11.
R12.
R13.
R14.
R15.
R16.
R17.
R18.
R19.

2.21

VAC 2006 - VAR 2006

Caratteristiche principali del controller

» Microfono frontale d’emergenza supervisionato.

 Sistema di diffusione sonora a 2 canali.

» Generatore di messaggi per diffusione di allarmi vocali a doppio canale (EVAC ed ALERT).

* Ingresso USB come sorgente di musica di sottofondo.

» Gestione automatica dellamplificatore di riserva.

* Ingresso per alimentazione secondaria (24 Vcc).

» 7 contatti d'ingresso programmabili e controllati.

» 3 uscite relé.

» 6 linee di controllo per gli amplificatori digitali Serie DPU e/o router VAR 2006 e/0 i sistemi integrati d’evacuazione VAIE 2250.
* 4 linee ridondabili per il collegamento tra i vari controller (max 6).

+ 2 linee ridondabili per le basi microfoniche d’'emergenza Serie FMD (max 7, con 7 livelli di priorita).

» 2 linee ridondabili per le postazioni di chiamata Serie MBT (max 16, con 7 livelli di priorita).

+ Display grafico monocromatico 128x64 pixel per una facile configurazione e veloce uso delle schermate di controllo.
» Diagnostica e segnalazione dei vari guasti.

* Montaggio standard a rack 19” (altezza 2 unita).

ROUTER VAR 2006

LED segnalazione guasti.

LED di stato router/sistema.

LED di stato zone d'uscita.

Pulsanti di selezione zone diffusione BGM.

LED di stato alimentazioni/chiamate.

Interruttore d’accensione.

N°2 uscite a rele per segnalazione verso periferiche esterne.
Morsettiera per alimentazione esterna in corrente continua 24Vcc.
Connessione di terra del telaio.

Spina per alimentazione di rete 230Vca con fusibile integrato.
Morsettiera per collegamento alle uscite degli amplificatori.
Morsettiere uscite altoparlanti.

Ingressi/uscite programmabili.

Uscita amplificatore voce - Uscita amplificatore musica/riserva.
Ingresso/uscita per collegamento a controller VAC 2006.

Caratteristiche principali del router

» 6 uscite di zona altoparlanti a doppia linea A e B.

» Doppio ingresso 100V per 1 o 2 amplificatori voce (IN 1 zone 1+3, IN 2 zone 4+6).

* Ingresso 100V per amplificatore musica/riserva.

» Possibilita di attivare/disattivare la musica per ogni zone tramite appositi pulsanti frontali.
» Prese RJ45 per il collegamento al controller VAC 2006.

» 7 contatti d'ingresso programmabili e controllati.

* 6 uscite open-collector.

» 2 uscite arelé.

* Montaggio standard a rack 19” (altezza 1 unita).
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I VAC 2006 * VAR 2006

3. AVVERTENZE

3.1 ALIMENTAZIONE E MESSA A TERRA

Questo apparecchio é predisposto per il funzionamento con tensione di rete a 230 V + 10% 50/60 Hz. Linterruttore di accensione (R1) agisce
sulla tensione di rete. In dotazione all'apparecchio e fornito un cavo di alimentazione con filo di terra; il terminale di terra della spina di rete non
deve essere rimosso in alcun caso. Collegare la spina di rete (R14) dell'apparecchio alla rete elettrica utilizzando esclusivamente I'apposito
cavo fornito in dotazione, che dispone di opportuno filtro anti-disturbo; assicurarsi che la presa di corrente sia dotata di collegamento di terra a
norma di legge. |l circuito d’alimentazione del VAC 2006 ¢ protetto da un fusibile situato sulla spina di rete dell’apparecchio.

3.2 NOTE DI SICUREZZA

Ogniintervento all'interno dell’apparecchio, quale operazioni di manutenzione od altro, deve essere effettuato solo da personale specializzato: la
rimozione del coperchio rende accessibili parti con rischio di scosse elettriche. Prima di rimuovere il coperchio accertarsi sempre che il cavo di
rete sia staccato. Nel caso di accidentale caduta di liquidi sul’apparecchio, staccare immediatamente la spina di rete ed interpellare il centro di
assistenza FBT piu vicino. Nel caso di installazione a rack si prescrive di collegare al telaio del rack la connessione (R13) per mezzo di un cavo
pili corto possibile (~20cm). E possibile anche collegare le altre apparecchiature presenti per la sola funzione di schermatura dei segnali a basso
livello e d’'immunita alle interferenze indotte: questa presa non deve essere utilizzata per il collegamento di sicurezza del telaio alla terra.

3.3 INSTALLAZIONE

Tutti gli apparecchi FBT sono costruiti nel rispetto delle piu severe normative internazionali di sicurezza ed in ottemperanza ai requisiti della
Comunita Europea. Per un corretto ed efficace uso dell’apparecchio € importante prendere conoscenza di tutte le caratteristiche leggendo
attentamente le presenti istruzioni ed in particolare le note di sicurezza. Durante il funzionamento dell’apparecchio € necessario assicurare
un’adeguata ventilazione, lasciando libera soprattutto la griglia superiore d’aerazione per le ventole di raffreddamento. Evitare di racchiudere
I'apparecchio in un mobile privo di aerazione o di tenerlo in prossimita di sorgenti di calore. Gli apparecchi possono essere montati in rack
standard da 19”.

Avvertenze per lo smaltimento del prodotto ai sensi della Direttiva Europea 2002/96/EC

Alla fine della sua vita utile il prodotto non deve essere smaltito insieme ai rifiuti urbani, ma deve essere consegnato presso gli appositi
centri di raccolta differenziata predisposti dalle amministrazioni comunali, oppure presso i rivenditori che forniscono questo servizio.
Smaltire separatamente un rifiuto elettrico e/o elettronico (RAEE) consente di evitare possibili conseguenze negative per 'ambiente e per
la salute derivanti da un suo smaltimento inadeguato e permette di recuperare i materiali di cui € composto al fine di ottenere un importante
risparmio di energia e di risorse. Su ciascun prodotto € riportato a questo scopo il marchio del contenitore di spazzatura barrato.

Questo prodotto &€ conforme alle Direttive della Comunita Europea sotto le quali lo stesso ricade.
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I VAC 2006 - VAR 2006

4. CONNESSIONI
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I VAC 2006 * VAR 2006

A) COLLEGAMENTO TRA CONTROLLER
Utilizzare un cavo CAT.5e SF/UTP nelle prese ‘VAC 2006 LINK’ (R3) per collegare tra di loro i controller del sistema (max 6).

B) COLLEGAMENTO LINEE D’USCITA

Utilizzare le prese ‘SLAVE LINK OUTPUTS’ (R9) per collegare al controller:
B1) Router VAR 2006.

B2) Sistema d’emergenza compatto VAIE 2250.

B3) Amplificatori Serie DPU.

B1) Router VAR 2006
Utilizzare un cavo CAT.5e SF/UTP per collegare le prese ‘SLAVE LINK OUTPUTS’ (R9) alle prese ‘IN/OUT SLAVE LINK’ sul router.
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B2) Sistema d’emergenza compatto VAIE 2250
Utilizzare un cavo CAT.5e SF/UTP per collegare una delle prese ‘SLAVE LINK OUTPUTS’ (R9) alla presa ‘REMOTE LINK’ del sistema compatto
VAIE 2250.

B3) Amplificatori Serie DPU
Utilizzare cavi CAT.5e SF/UTP per collegare una delle prese ‘SLAVE LINK OUTPUTS’ (R9) alla presa ‘IN/OUT’ dellamplificatore
(DPU 1125C, DPU 1250C o DPU 1500C).
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C) COLLEGAMENTO POSTAZIONI D’EMERGENZA

Utilizzare un cavo CAT.5e SF/UTP per collegare le prese ‘EMERGENCY
UNITS’ (R2) del controller alle prese ‘IN/OUT’ delle postazioni FMD 2001
e/o FMD 2012.

D) COLLEGAMENTO INGRESSI AUDIO

Per dettagli sulle impostazioni fare riferimento alle relative sezioni indicate in menu MUSIC ed AUDIO SETTING.

D1) Sorgenti Musicali BGM, canale d’amplificazione “musica”

Collegamento di esempio di sorgenti sonore a livello linea o microfonico, bilanciate o sbilanciate, selezionabili dal pannello MUSIC e indirizzabili
alle zone desiderate tramite i tasti di attivazione zona. Per dettagli sulle impostazioni fare riferimento alle relative sezioni indicate in menu MUSIC

ed AUDIO SETTING.

A - Sorgente musicale con uscita sbilanciata a livello di linea collegata all'ingresso AUX IN.
Per l'ascolto selezionare dal Menu MUSIC la sorgente BGM "AUX”

B - Ricevitore del kit radio-microfonico con uscita bilanciata a livello microfonico collegata all'ingresso IN.1.

Per l'ascolto selezionare dal Menu MUSIC la sorgente BGM “INPUT 1”
Impostare al Pannello INPUT 1: >MODE: OFF
>PH: OFF
>| parametri Chime, Priority e Zone list non hanno effetto

C - Mixer con uscita bilanciata a livello Linea collegata all'ingresso IN.2 LINE.
Per I'ascolto selezionare dal Menu MUSIC la sorgente BGM “INPUT 2”
Impostare al Pannello INPUT 2: >MODE: OFF
>PH: OFF
>| parametri Chime, Priority e Zone list non hanno effetto

Attenzione! Non collegare altre apparecchiature alla presa MIC dell’ingresso IN.2.
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D2) Sorgenti PA di varia tipologia a priorita scalare, canale d’amplificazione “voce”

Collegamento di esempio di 1 postazione microfonica da tavolo, non pre-amplificata, con contatto di precedenza; di 1 microfono ad impugnatura
con attivazione automatica VOX sulla musica; di 1 centralino telefonico con uscita audio per annuncio automatico sull’impianto diffusione sonora
e postazioni digitali serie MBT per annunci di servizio con selezione a zone. Per dettagli sulle impostazioni fare riferimento alle relative sezioni
indicate in AUDIO SETTING.

A - Base da tavolo con microfono elettrete, uscita bilanciata collegata
all’ingresso IN.1- MIC e contatto di precedenza collegato all'ingresso
PREC.
L'annuncio sara indirizzato sul gruppo di zone riferite alla ZONE LIST secondo
la priorita impostata.
Impostare al Pannello INPUT 1: >MODE: PRECEDENCE

>PH: ON

>Priority: 3

>Zone list come desiderato

>VOL.: come desiderato
Impostare al Pannello CHIME: > MIC 1: ON

B - Microfono dinamico a impugnatura, uscita bilanciata collegato all'ingresso
IN.2— MIC con funzione VOX.
L'annuncio sara indirizzato sul gruppo di zone riferite alla ZONE LIST secondo
la priorita impostata.
Impostare al Pannello INPUT 2: >MODE: VOX

>PH: OFF

>Priority: 1

>Zone list come desiderato

>VOL.: come desiderato
Impostare al Pannello CHIME: > MIC 2: OFF

Attenzione! Non collegare altre apparecchiature ai morsetti LINE
dell’ingresso IN.2.

C - Postazioni microfoniche digitali collegate in cascata all'ingresso PAGING
UNITS). Lannuncio sara indirizzato sulle zone riferite alla programmazione dei
tasti delle basi stesse secondo la priorita impostata per ciascuna base.
Impostare Pannello PAGING UNITS:
>V/OL.: come desiderato (volume generale
della linea per tutte le basi)
Impostare al Pannello CHIME: > UNIT: ON

Dimensionamento: Per ciascuna unita VAC 2006 possono essere collegate fino a massimo 16 postazioni serie PAGING UNITS. Utilizzare il cavo di
collegamento tipo CAT. 5e SF/UTP, con trecciola di schermo. Possono essere mantenuti i seguenti limiti di collegamento:

N. 1 postazione collegata su 1 linea lunga 800m.

N. 8 postazioni distribuite su 2 linee lunghe 200m ciascuna (4 postazioni per linea).

Per impianti che prevedono distanze superiori o piu postazioni collegate, sara opportuno alimentare le postazioni con I'alimentatore aggiuntivo collegato
alla presa locale della base. La lunghezza massima della linea di collegamento, sommando le linee collegate alle 2 prese RJ45 € di 1km; per ulteriori
dettagli sul tipo di alimentazione, sulla formazione del cavo, sulla programmazione dei tasti di selezione, sull'impostazione delle priorita e degli indirizzi,
fare riferimento al manuale istruzioni della postazione serie MBT.

Le unita PAGING UNITS collegabili al VAC 2006 sono di seguito elencate:
e MBT 1106: postazione di chiamata a 6 zone.
*« MBT 1112: postazione di chiamata a 12 zone.

I collegamenti tra VAC 2006 e postazioni microfoniche sono da effettuarsi esclusivamente con cavi di tipo CAT. 5e SF/UTP.
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E) CONTATTI D’INGRESSO RJ45 “CONTROL INPUTS”
Alla presa CONTROL INPUTS (R8) sono disponibili 7 contatti, di cui 6 controllati (1+6): in figura un esempio di collegamento.

NOTA: Nell’esempio, i contatti da 1 a 6 sono controllati, mentre il contatto 7 non lo e.

F) COLLEGAMENTO ALIMENTAZIONE ESTERNA

Ai morsetti (R12) & disponibile la connessione per un’alimentazione
esterna a 24Vcc.
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5. OPERATIVITA E NOMENCLATURA

5.1 DEFINIZIONI GENERALI

Di seguito un elenco delle modalita di segnalazioni delle condizioni operative del sistema e di definizioni utilizzate nei successivi paragrafi del
manuale, completate da indicazioni di carattere generale:

5.1.1 Segnalazione delle condizioni operative
Il controller VAC 2006 ¢ strutturato per segnalare le differenti condizioni operative come da seguenti definizioni:

“Stato di Quiete” (Led ALARM - FAULT - DIS - SYS spenti)
Condizione operativa normale, senza guasti o emergenze in corso. Consente la gestione delle sorgenti musicali e delle sorgenti voce per
annunci di servizio.

“Stato di Allarme” (Led ALARM acceso)

Condizione operativa che segnala la presenza di almeno un segnale di allarme, pre-registrato o a viva-voce, in corso su almeno una zona
d’uscita. Lo “Stato di Allarme” puo essere attivato da una Emergenza Automatica attivata da una periferica esterna collegata agli ingressi di
controllo “Control Inputs” oppure da una Emergenza Manuale tramite operatore autorizzato. Durante lo “Stato di Allarme” le funzioni delle sorgenti
musicali e delle sorgenti voce riferite allo Stato di Quiete non sono operative.

“Stato di Guasto” (Led FAULT)

Condizione operativa che segnala la presenza di almeno un guasto in corso, rilevato dal sistema di diagnosi interna con 'accensione fissa del
LED FAULT.

In caso di guasto di un controller remoto, il LED FAULT lampeggia.

E accompagnato dalla segnalazione acustica di guasto (buzzer). Se le cause del guasto lo permettono, il sistema pud svolgere comunque le
funzioni relative agli stati di “Quiete” e di “Allarme”.

“Guasto di sistema” (Led SYS acceso)

Condizione operativa che segnala il blocco del sistema causato da un malfunzionamento temporaneo o permanente della CPU, rilevato dal
watchdog di supervisione. E’ accompagnato dalla segnalazione acustica di guasto (buzzer). Durante il guasto di sistema, le funzioni riferite agli
stati di “Quiete” e di “Allarme” non sono operative.

“Stato di Disabilitazione” (Led DIS acceso)

Condizione operativa che segnala I'impostazione della Disabilitazione dei segnali di Allarme per almeno una zona di uscita. Il sistema puo
svolgere comunque le funzioni riferite allo “Stato di “Quiete” per tutte le zone, e, per le sole zone non disabilitate, le funzioni riferite allo “Stato
di Allarme”.

“Emergenza Automatica” (Display CONTROL INPUT STATUS con zone attive)
sequenza di operazioni svolte da periferica esterna, collegata agli ingressi di controllo (Control Inputs), che, in base alla programmazione degli
stessi ingressi, attiva la condizione di “Stato di Allarme” o il Reset degli allarmi.

“Emergenza Manuale” (Led del pulsante EMERGENCY acceso/lampeggiante)

procedura di intervento sui controlli manuali del sistema, da parte di operatore autorizzato, per I'attivazione di Sorgenti d’'Emergenza o il Reset degli
Allarmi (Reset Alarm Manuale). Le operazioni svolte in Emergenza Manuale hanno priorita superiore a quelle attivate dal’Emergenza Automatica.
Il controller VAC 2006 o la postazione d’emergenza con il led EMERGENCY acceso € abilitata all’'uso per I'attivazione di Sorgenti d’Emergenza
o il Reset degli Allarmi. Il controller VAC 2006 o la postazione d’emergenza con il led EMERGENCY lampeggiante, segnala che 'Emergenza
Manuale é stata attivata da una postazione remota.

5.1.2 Glossario
Di seguito un elenco di definizioni utilizzate nei successivi paragrafi del manuale e completate da indicazioni di carattere generale.

“Sorgente BGM”:

una delle seguenti sorgenti audio che impegnano il canale di amplificazione “musica” (BackGround Music):

- Sorgente audio collegata all'ingresso AUX.

- Sorgente audio collegata all'ingresso IN 1 (Microfonico) con modalita impostata MODE: IN OFF.

- Sorgente audio collegata all'ingresso IN 2 (Microfonico oppure di Linea) con modalita impostata MODE: IN OFF.
Durante lo “Stato di Allarme” le sorgenti BGM non sono operative.

“Sorgente PA”:

una delle seguenti sorgenti audio che impegnano il canale di amplificazione “voce” per annunci di servizio, (Public Address):

- Sorgente sonora collegata all'ingresso IN 1 (Microfonico) con modalita impostata MODE: ON o PRECEDENCE.

- Sorgente sonora collegata all'ingresso IN 2 (Microfonico oppure di Linea) con modalita impostata MODE: ON, VOX o PRECEDENCE.
- Sorgente sonora collegata all'ingresso IN 3 (Linea) con modalita impostata MODE: ON o VOX.

- Postazione d'emergenza (EMERGENCY UNITS) in modalita broadcast, postazione microfonica digitale di chiamata (PAGING UNITS).
Durante lo “Stato di Allarme” le sorgenti PA non sono operative.

Manuale di sistema | 2013 15 VAIE 2000 | Voice Alarm Integrated Systems



“Sorgente d’Emergenza”:

VAC 2006 * VAR 2006

una delle seguenti sorgenti audio che impegnano i canali di amplificazione “voce” e/o “musica” per annunci di emergenza vocale (Voice

Evacuation System):

- Messaggio pre-registrato di Allerta (ALERT).

- Messaggio pre-registrato di Evacuazione (EVAC).

- Microfono di Emergenza (P.T.T.) collegato alla presa frontale MICROPHONE.

- Postazione Microfonica di Emergenza collegata alla presa posteriore EMERGENCY UNITS.
Lattivazione di una “Sorgente d’Emergenza” genera la condizione operativa di “Stato di Allarme”.

“Priorita”:

Limpegno delle zone di uscita, da parte di una segnale audio o di un comando di reset & regolato gerarchicamente dal livello di priorita assegnato

a ciascuna sorgente attiva.

Una attivazione in corso sulla zona, pud essere interrotta solo da un’altra a priorita superiore.

Il sistema VAC 2006 gestisce le priorita come da seguenti tabelle:

Priorita Condizione Ambiente
del sistema operativo
alta
Emergenza
Manuale
“Stato d’Allarme”
Emergenza
Automatica
bassa
Priorita Condizione Ambiente
del sistema operativo
alta
Sorgente
PA
“Stato di Quiete”
Sorgente
bassa BGM

Livello
Priorita

15
da8a14
7
6
5

Livello
Priorita

da8a14

data7

Sorgente
attiva

VAC 2006 con microfono d’emergenza a bordo
Postazioni microfoniche d’'emergenza
CONTROL INPUT per funzione Reset
CONTROL INPUT per messaggio EVAC
CONTROL INPUT per messaggio ALERT

Sorgente
attiva

Postazioni d’Emergenza in modalita broadcast

Ingressi IN 1 - IN 2 con funzione
PRECEDENZA o VOX

PAGING UNITS Postazioni microfoniche

Sorgente musicale

Per impostazioni vedi
MENU

Impostazione fissa
Vedi manuale postazioni FMD 2001, FMD 2012
Impostazione fissa
Impostazione fissa

Impostazione fissa

Per impostazioni vedi
MENU

Vedi manuale postazioni
Vedi sezione AUDIO SETTING

Vedi manuale MBT 1106, MBT 1112

Impostazione fissa

Le sorgenti attive in condizione di “Stato d’Allarme” hanno sempre priorita superiore a quelle attive in “Stato di Quiete”, indipendentemente dal livello di

priorita impostato.
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5.2

VAC 2006 VAR 2006

DOTAZIONI E CARATTERISTICHE FUNZIONALI

5.2.1 Controller VAC 2006

Pannello frontale

F1.

F2.

F3.

Pulsante Emergency con Led (rosso)

Pulsante incassato per l'attivazione della modalita di Emergenza Manuale. Permette I'accesso al sistema, con priorita assoluta, dallo
“Stato di Quiete” o durante 'Emergenza Automatica in corso, precedentemente attivata da periferiche esterne. Il LED, normalmente
spento, sara acceso durante la modalita di Emergenza Manuale attivata dalla propria unita; il led lampeggiante indica lo stato d’'Emergenza
Manuale attivata da una postazione microfonica d'emergenza o da un controller remoto. Il pulsante EMERGENCY sara utilizzato anche
per l'uscita dal’Emergenza Manuale. |l pulsante & controllato dal sistema di diagnosi interno.

Microfono d’emergenza

Microfono palmare con tasto di attivazione Push to Talk (P.T.T.) per annunci di emergenza a viva-voce. Il microfono € operativo solo in
condizioni di Emergenza Manuale ed & prioritario sui messaggi pre-registrati di emergenza. La capsula del microfono & controllata dal
sistema di diagnosi interno. Utilizzare esclusivamente il microfono fornito in dotazione, collegato senza prolunghe alla presa XLR sul pannello
frontale del VAC 2006.

DISPLAY grafico

Display grafico retroilluminato monocromatico da 128x64 pixel, per la visualizzazione delle molteplici finestre di gestione, che saranno a
contenuto variabile in base alle condizioni operative di riposo o di emergenza del sistema. In abbinamento alla Manopola (+/-) e ai tasti
multifunzione, aiuta la navigazione fra i menu, la regolazione dei parametri di lavoro, la gestione delle funzioni avanzate e I'indicazione
aggiuntiva di tutte le informazioni richieste, per gli stati di Guasto, Disabilitazione e Voice Alarm, che non sono completamente segnalate
dai led di stato previsti.

Pannello posteriore

R1.

R2.

R3.

Interruttore POWER

Interruttore di accensione del sistema VAC 2006. In posizione O (OFF) il sistema € spento, in posizione | (ON) il sistema & acceso. Linterruttore
€ operativo solo sull’'alimentazione principale 230Vca (consultare i paragrafi “Alimentazione e messa a terra” e “Note di sicurezza” per
dettagli sulla sicurezza).

EMERGENCY UNITS

Ingressi per il collegamento delle postazioni microfoniche di emergenza remote. Utilizzare esclusivamente le postazioni microfoniche
FBT FMD 2001 e/o FMD 2012. Prese RJ45 per collegamento con cavo CAT.5e SF/UTP con calza di schermo e connettore schermato
STP (per i dettagli di collegamento far riferimento al manuale delle postazioni cod. FBT 37359). Il collegamento delle EMERGENCY
UNITS deve essere realizzato a catenella (daisy-chain): le 2 linee di collegamento A e B possono essere lunghe, sommate in totale, fino
a 1 km (ognuna).

VAC 2006 LINK Prese per il collegamento tra controller VAC 2006 (fino a 6)
Connessioni per collegamento tra pit controller. Utilizzando sia il LINK A che il LINK B si ottiene una connessione ridondante che mantiene
operativo il sistema anche se viene a mancare una delle due connessioni. In caso di piu controller all'interno dello stesso rack, & possibile
utilizzare una sola connessione LINK (A o B): a tal proposito, &€ necessario disattivare il remote link test non utilizzato:

o Percorso: HOME / CONFIGURATION / set> BACKGROUND TEST | 2-Voice Alarms / 6-Remote Link > Link Test
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R4.

R5.

VAC 2006 * VAR 2006

PAGING UNITS

Ingresso per il collegamento di postazioni microfoniche di chiamata (MBT 1106, MBT 1112) per le funzioni di servizio broadcast. Possono
essere collegate in totale fino a 16 Unita di Paging. Prese RJ45 (n.2) per collegamento con cavo CAT.5e SF/UTP con calza di schermo e
connettore schermato STP. Il collegamento delle Paging Units deve essere realizzato a catenella (daisy-chain) le 2 linee di collegamento
possono essere lunghe, sommate in totale, fino a 1 km.

IN. 2 - MIC. / LINE e MORSETTO DI PRECEDENZA
Ingresso INPUT 2 bilanciato per microfono o sorgente esterna, programmabile come sorgente Musica o come sorgente Voce. Utilizzare
l'ingresso MIC. Per il collegamento di microfoni dinamici o elettrete abilitando I'alimentazione phantom, oppure in alternativa, I'ingresso a
morsettiera per sorgenti a livello linea tipo mixer o postazioni microfoniche preamplificate. La programmazione della modalita di funzionamento
permette molteplici impostazioni dell'ingresso:
- come sorgente voce abilitato da contatto di precedenza (PREC.), con CHIME attivabile/disattivabile.
- come sorgente voce ad attivazione automatica VOX con regolazione della soglia di intervento, del tempo di rilascio, ed eventuale CHIME
attivabile/disattivabile.

Quando utilizzato come sorgente voce puo essere impostata la priorita, regolabile su 7 livelli, e il gruppo delle zone di chiamata.

Non utilizzare contemporaneamente gli ingressi MIC. e LINE dell'ingresso IN. 2, bensi:

- Lapresa XLR-F per il collegamento di segnale bilanciato fino a 100mV, oppure

- La presa con 3 morsetti per fili a spelare, HOT-COM-GND per il collegamento di segnale bilanciato fino a 1.8V.

In entrambi i casi, utilizzare cavo microfonico bilanciato schermato. Per i dettagli sulle impostazioni dell'ingresso IN. 2, fare riferimento alle

indicazioni riportate nei Menu MUSIC ed AUDIO SETTING > INPUT 2 e CHIME.

MORSETTIERA DI PRECEDENZA

Morsettiera per il collegamento del contatto di precedenza sulla musica in corso, per attivazione dell'ingresso IN. 1 0 IN. 2 e del tono di preavviso
(CHIME) se abilitato. La funzione di precedenza puo essere utilizzata nel MIC 1 o nel MIC 2 se abilitata nei rispettivi pannelli: per i dettagli
sulle impostazioni della precedenza, fare riferimento alle indicazioni riportate nei pannelli INPUT 1, INPUT 2 e dal Menu AUDIO SETTING.
Lattivazione si effettua mantenendo collegato il morsetto +12V al morsetto PR. tramite la chiusura di un contatto pulito o collegando il contatto
di precedenza disponibile sui microfoni da tavolo.

R6.

R7.

R8.

R9.

R10.

R11.

R12.

R13.

R14.

IN.1-MIC 1

Ingresso INPUT 1 per microfono esterno, programmabile come sorgente Musica o come sorgente Voce. Possono essere collegati microfoni
dinamici o elettrete abilitando I'alimentazione phantom. La programmazione della modalita di funzionamento ne permette I'utilizzo come
sorgente voce abilitato da contatto di precedenza (PREC.), con CHIME attivabile/disattivabile.

Quando utilizzato come sorgente voce puo essere impostata la priorita di intervento, regolabile su 7 livelli, e il gruppo delle zone di chiamata.
La presa XLR-F permette il collegamento di segnale bilanciato fino a 100mV, da realizzare con cavo microfonico bilanciato schermato.
Per i dettagli sulle impostazioni dell'ingresso IN. 1, fare riferimento alle indicazioni riportate nel pannello INPUT 1 (par. 8.3.4).

AUXIN
Ingresso per il collegamento di una sorgente musicale esterna. N. 1 coppia di prese RCA, con conversione in monofonia, per sorgenti con
uscite sbilanciate a livello linea. Per le regolazioni audio dell'ingresso AUX, fare riferimento alle indicazioni riportate nel Menu MUSIC.

CONTROL INPUTS

N. 7 ingressi digitali monitorati per controllo da periferiche esterne. Permette l'attivazione di eventi programmati, compresa la commutazione
del controller VAC 2006 nelle condizioni di Emergenza Vocale, che richiedono l'invio automatico di messaggi preregistrati di emergenza.
L'attivazione € possibile tramite contatti di stato Normalmente Aperto o Normalmente Chiuso, con riporto della tensione +24Vcc fornita
dalla presa CONTROL INPUT. E’ possibile abilitare la diagnosi della tratta di collegamento, provvedendo all'installazione di 2 resistenze
di bilanciamento da 10kOhm in prossimita del contatto di attivazione della periferica remota (vedi schema a pag. 14).

SLAVE LINK OUTPUTS
N. 6 linee di uscita per collegamento ad amplificatori DPU e/o sistemi d’'emergenza compatti VAIE 2250 e/o router VAR 2006.

LAN
Presa di collegamento per Local Area Networkcon protocollo TCP/IP di rete Ethernet 10/100.

RELAY 1 - RELAY 2 - RELAY 3

N. 3 uscite a relé per segnalazione verso periferiche esterne. Il controller VAC 2006 permette la programmazione delle uscite logiche
abbinando I'attivazione dell’'uscita ad eventi di stato del sistema o per funzioni di override in emergenza o per la segnalazione dei guasti,
dellemergenzain corso e della disabilitazione. Tutte le uscite possono essere programmate per stato Normalmente Attivo o Normalmente
Disattivo. Il collegamento prevede n. 3 morsetti a vite per fili a spelare per ciascun relé, riferiti ai contatti N.O. - N.C. - Scambio.
Nota: nel router VAR 2006 le uscite a disposizione sono 2.

Morsetti per alimentazione esterna in corrente continua 24Vcc

Morsetti per il collegamento del sistema di alimentazione ausiliaria a corrente continua 24Vcc. Quando & presente I'alimentazione principale
a 230Vac, I'alimentazione a 24Vcc non viene utilizzata. Lingresso € protetto contro l'inversione della polarita. Consultare la sezione
“Alimentazione e messa a terra” e “Note di sicurezza” per dettagli sulla sicurezza. N.B. Le batterie ed il caricabatterie devono essere
installati nello stesso rack in cui € montato il controller VAC 2006.

Morsetto di terra del telaio

Connessione di terra del telaio, permette di collegare il riferimento a telaio di altre apparecchiature per la funzione di schermatura dei
segnali di basso livello. Non deve essere utilizzata per il collegamento di sicurezza del telaio a terra. (Consultare la sezione “Alimentazione
e messa a terra” e “Note di sicurezza” per dettagli sulla sicurezza).

Spina per alimentazione di rete 230Vac con fusibile integrato

Spina per il collegamento dell’alimentazione di rete principale 230Vac/50-60Hz, utilizzare il cavo di rete fornito in dotazione. Il fusibile di
rete da 500mAL, del tipo cilindrico da 20mm miniatura, deve essere sostituito solo con un altro di caratteristiche identiche (consultare
la sezione “Alimentazione e messa a terra” e “Note di sicurezza” a pag. 8).
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5.2.2 Router VAR 2006

Pannello frontale

F4.

F5.

F6.

F7.

F8.

LED FAULTS

| LED FAULTS danno le seguenti indicazioni:

« COM-SYS Se lampeggia, indica la mancanza di connessione con il controller.

e CTRLIN Indica un guasto degli ingressi controllati.

* MAINS Indica un guasto dell’alimentazione interna.

« BATTERY Indica la mancanza di alimentazione dalla batteria.

« GND Ground Fault.

* SP.Z1-3 Guasto dell’lamplificatore collegato alle zone Z1 + Z3.

* SP.Z4-6 Guasto dellamplificatore collegato alle zone Z4 + Z6.

« MUS.-SPARE Guasto dell’lamplificatore musica/riserva.

LED STATUS

| LED STATUS danno le seguenti indicazioni:

« ALARM Indica la presenza di un messaggio d’'emergenza vocale e/o registrato in corso (generico).

¢ CTRLIN Indica messaggio d’emergenza vocale e/o registrato in corso proveniente da uno dei contatti d’ingresso.
- DISABLE Indica la presenza di almeno una zona per cui non € prevista la diffusione di messaggi d'emergenza.
* FAULT Indica la presenza di un guasto in almeno una delle 6 linee d'uscita.

LED ZONE OUTPUT

| LED rossi MSG indicano in tempo reale la/e zona/e in cui viene diffuso il segnale d’emergenza vocale:

Se lampeggianti Messaggio d’allerta in corso.

Se accesi fissi Messaggio d’evacuazione o vivavoce in corso.

| LED gialli LINE A/B indicano:

Se lampeggianti Guasto di zona: 'impedenza misurata sulla zona € al di fuori dei limiti impostati.

Se accesi fissi Indica le zone in cui non & prevista la diffusione di messaggi d’'emergenza (funzione DISABLE).

PROGRAM INSERTION
| LED danno le seguenti indicazioni:

Se lampeggianti La zona in cui & in corso la diffusione di una chiamata broadcast (NON emergenza).
Se accesi fissi Nella zona ¢ attivata la musica di sottofondo (funzione possibile solo se € presente anche I'amplificatore.
MUS.-SPARE).

| pulsanti permettono l'inserzione della musica di sottofondo nelle zone corrispondenti (funzione possibile solo se € presente anche
'amplificatore MUS.-SPARE).

LED di stato

LED di stato alimentazioni/chiamate:

- EMERG. Indica che il sistema € in stato d’emergenza.

« CALL Indica che € in corso una chiamata broadcast.

« ON Indica la presenza dell’alimentazione 230Vca.

* BATT. Indica la presenza dell’alimentazione esterna 24Vcc.
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Pannello posteriore

R1.

R11.

R12.

R13.

R14.

R15.

R16.

R17.

R18.

R19.

5.2.3

C1.

C2.

Interruttore POWER
Vedi pagina 17.

RELAY 1 - RELAY 2
N. 2 uscite a relé per segnalazione verso periferiche esterne (vedi pagina precedente).

Morsetti per alimentazione esterna in corrente continua 24Vcc
Vedi pagina 18.

Morsetto di terra del telaio
Vedi pagina 18.

Spina per alimentazione di rete 230Vac con fusibile integrato
Vedi pagina 18.

Morsetti MUSIC SPARE / SPEECH )
Morsettiera per collegamento alle uscite degli amplificatori voce e musica/spare. E possibile impostare quattro diverse configurazioni di
collegamento.

Morsetti Z1A/B+Z6A/B

Uscite di potenza per linee diffusori sonori. Utilizzare solo diffusori sonori con traslatore di linea a 100V tensione costante. Sono disponibili
n. 6 zone di uscita e ciascuna zona € divisa in 2 linee A e B per la realizzazione della rete altoparlanti a doppia linea ridondante. In caso di
corto-circuito di una linea, il sistema VAIE 2250 disattivera I'uscita per la linea guasta, e continuera ad alimentare I'altra linea della stessa
zona, attivando la segnalazione di Guasto in corso. Per il collegamento delle linee 0V-100V sono disponibili n. 12 coppie di morsetti a
vite per cavi di sezione fino a 2,5 mm?2.

Prese CONTROL

* N. 7 ingressi digitali monitorati per controllo da periferiche esterne. Permette I'attivazione di eventi programmabili, nelle condizioni di
Emergenza Vocale, che richiedono l'invio automatico di messaggi preregistrati di emergenza. Lattivazione e possibile tramite contatti di
stato Normalmente Aperto o Normalmente Chiuso, con riporto della tensione +24Vcc fornita dalla presa CONTROL. E possibile abilitare la
diagnosi della tratta di collegamento, provvedendo all'installazione di 2 resistenze di bilanciamento da 10kOhm in prossimita del contatto
di attivazione della periferica remota. Il collegamento prevede una presa RJ45 con cavo CAT.5e SF/UTP.

* N. 6 uscite open collector per il pilotaggio di rele esterni o periferiche generiche. Il sistema VAIE 2000 permette la programmazione
delle uscite logiche abbinando I'attivazione dell’'uscita ad eventi di stato del sistema o per funzioni di override in emergenza o per la
segnalazione dei guasti del’emergenza in corso e della disabilitazione. Le uscite possono essere programmate per stato Normalmente
Aperto o Normalmente Chiuso e dispongono della tensione 24Vcc interna con protezione auto-ripristinante. Il collegamento prevede una
presa RJ45 con cavo CAT.5e SF/UTP.

Spine microfoniche SPEECH e MUSIC/SPARE
 SPEECH Collegamento agli amplificatore/i voce.
« MUSIC/SPARE Collegamento allamplificatore musica/spare.

Prese SLAVE LINK IN/OUT
Ingresso/uscita per collegamento alle corrispondenti prese del controller VAC 2006 (presa RJ45 con cavo CAT.5e SF/UTP).

Pannello comandi controller

Altoparlante monitor/beep

Altoparlante integrato per la segnalazione acustica di guasto rilevato (beep). Il tono di segnalazione, verra silenziato automaticamente
se le condizioni di guasto terminano. Inoltre, al fine di evitare inneschi per effetto Larsen, sara tacitato dal sistema durante I'utilizzo del
Microfono di Emergenza.

Pulsante RESET

Tasto per il silenziamento manuale dei messaggi pre-registrati di Emergenza, operativo in ambito di Emergenza Manuale. Tasto per il
sislenziamento del buzzer e per 'annullamento della segnalazione del guasto, operativo in condizioni di guasto in corso o guasto rientrato.
In modalita di riposo, il tasto non & operativo.
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C3.

C4.

C5.

C6.

CT.

Cs.

Co.

C10.

C1.

c12.

VAC 2006 VAR 2006

Pulsante ALERT
Tasto per I'invio manuale del messaggio pre-registrato di Allerta, operativo in ambito di Emergenza Manuale. In modalita di riposo, il tasto
non € operativo.

Pulsante EVAC
Tasto per l'invio manuale del messaggio pre-registrato di Evacuazione, operativo in ambito di Emergenza Manuale. In modalita di riposo,
il tasto non & operativo.

Tasto MENU
Tasto multifunzione per accesso alla Home, per navigazione fra i menu e per funzioni specifiche dei sottomenu indicate sul display.

Tasto OK
Tasto multifunzione per conferma della selezione, per navigazione fra i menu e per funzioni specifiche dei sottomenu indicate sul
display.

Tasto ESC
Tasto multifunzione per ritorno al Menu Musica, per navigazione fra i menu e per funzioni specifiche dei sottomenu indicate sul display.

Tasti numericida1a6

Tasti multifunzione, operativi in tutti gli ambiti del sistema. Sono assegnati alla selezione delle zone da zona 1 a zona 6 per il controller
VAC 2006 in uso. Consentono di inserire la password di accesso oppure applicare le specifiche funzioni indicate sulla barra di stato del
display.

Indicazioni di stato

* Led ALARM (rosso)

Led di segnalazione dello “Stato di Allarme” in corso (VOICE ALARM). La condizione di VOICE ALARM puo0 essere stata attivata sia
automaticamente da una periferica esterna, sia manualmente dall’'operatore del VAC 2006 o di una postazione microfonica di emergenza.
Durante la condizione di VOICE ALARM, le funzioni standard di riproduzione musicale € il servizio delle sorgenti voce sono disabilitate.
In “Stato di Quiete” il led ALARM é spento.

* Led FAULT (giallo)

Led di segnalazione dello “Stato di Guasto” in corso. Indica che il sistema di diagnosi ha rilevato almeno una condizione di guasto, per
il controller VAC 2006 in uno o per gli elementi diagnosticati collegati ad essa. In caso di condizione di guasto terminata, il led FAULT si
spegne automaticamente e la scritta “RES” viene riportata nel display dei Guasti (FAULTS) a segnalare che ¢ stato rilevato un guasto
successivamente rientrato (RESUMED); la segnalazione di FAULT RESUMED verra spenta dopo aver completato la procedura di RESET
FAULT MANUALE. La segnalazione di FAULT pud essere attiva anche durante le funzioni standard di riproduzione musica e voce (Stato
di Quiete), e di Emergenza (Stato di Allarme), se la tipologia del guasto lo permette.

* Led DIS. (giallo)

Led di segnalazione della condizione attiva di Disabilitazione delle zone di emergenza (DISABLING). La segnalazione di DISABLING
indica che almeno una zona é stata disattivata dall’emergenza prevista in configurazione impianto e puo essere attiva anche durante le
funzioni standard di riproduzione musicale e di servizio delle sorgenti voce.

* Led SYS (giallo)

Led di segnalazione della condizione di “Guasto di Sistema” (System CPU Fault) in corso. Quando il led SYS & acceso, tutte le funzioni
operative, sia standard che di emergenza sono disabilitate.

* Led BATT. (verde)

Led di segnalazione dell'alimentazione ausiliaria 24Vcc. Il led BATT. acceso indica che I'alimentazione a tensione continua 24Vcc &
collegata al sistema.

* Led ON (verde)
Led di segnalazione del controller VAC 2006 acceso e operativo.

Il led ON rimane acceso in caso di:

- alimentazione 230Vac presente e interruttore POWER in ON.

Il led ON rimane lampeggiante in caso di:

- alimentazione 230Vac assente ed alimentazione 24Vcc presente.

Il Led ON rimane spento nel caso di:

- alimentazione 230Vac assente e alimentazione 24Vcc assente, oppure

- alimentazione 230Vac presente, alimentazione 24Vcc assente ed interruttore POWER in OFF.

Manopola +/-

Comando rotativo senza fine corsa, multifunzionale in base allo specifico menu operativo; permette lo spostamento del cursore, la
selezione e la regolazione dei valori. In condizione di riposo, nel menu musica, € utilizzato come regolazione diretta del volume master
di uscita del la Sorgente BGM.

Presa USB “EXT.”
Presa USB alimentata di tipo A, per il collegamento di memorie flash esterne (previsione).

Presa USB “TO PC”
Presa USB di tipo B, predisposizione per il collegamento del PC di gestione per uso del Software di Sistema.
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6. CONFIGURAZIONE DELL’IMPIANTO

6.1 INTRODUZIONE

Il software Controller Manager consente di compilare e configurare l'intero sistema che si vuole realizzare. Cliccare due volte sul file “controller.
exe” per avviare il programma.

Nota: per il corretto funzionamento del programma, € necessario che il pc sia dotato di Sistema Operativo Windows 7® o superiore.

6.2 CREAZIONE DI UN NUOVO FILE PROGETTO

Una volta avviato il programma € gia possibile creare una nuova configurazione d’impianto.

Per creare il nuovo file, selezionare File > New Project dalla barra dei menu.

Per aggiungere una descrizione al progetto, selezionare Project > Edit Description e digitare nell’apposito campo (max 22 caratteri).

Per salvare il nuovo progetto, selezionare File > Save Project As: tramite la finestra di dialogo assegnare un nome al progetto ed individuare, o
creare, la cartella di destinazione. La conferma della riuscita dell'operazione sara indicata dalla barra di stato inferiore della finestra.

Una volta effettuate queste operazioni, & possibile iniziare la configurazione del sistema.
Per salvare il progetto aperto € sufficiente selezionare la voce File > Save Project*.

6.3 APERTURA DI UN PROGETTO ESISTENTE

Per aprire un progetto precedentemente salvato, selezionare File > Open Project; dalla finestra di dialogo selezionare la cartella ed il file *.prg
desiderato.

* In qualsiasi momento € possibile passare alla compilazione di un nuovo progetto selezionando File > New Project; ovviamente, tutti i dati
precedentemente inseriti andranno persi, in quanto il programma ripartira da un progetto vuoto.
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6.4 INSERIMENTO DEI CONTROLLER

Tramite il menu Tools > Insert Controller aggiungere il numero di VAC
2006 previsti nel sistema (nel nostro esempio, le unita sono 2).
Perimpostazione difabbrica, il controller con indirizzo 0 viene denominato
“Master” e deve necessariamente esistere in ogni progetto.

6.5 CONFIGURAZIONE DEL CONTROLLER

Passiamo ora alla configurazione delle singole linee per ciascun
controller, a cominciare proprio dal Master di cui impostiamo i parametri
per la linea 1.

Premere il pulsante LINE 1 > Configure: si apre una schermata in cui
€ possibile selezionare quale apparecchio € collegato a questa linea
(nessuno, router VAR 2006, amplificatori DPU o sistema compatto
VAIE 2250).

Selezionare I'opzione desiderata e cliccare su Continue >.

Ogni opzione porta ad una specifica schermata dedicata, tranne la
voce “NONE” che riporta la linea alla condizione di non utilizzo.

* VAR 2006 - router

Selezionando questa voce, si apre la schermata Line 1 configuration, dove € possibile selezionare caratteristiche di zone, contatti d’'ingresso e
contatti d’uscita del router. Inoltre, pud essere indicata la presenza di amplificatori collegati. Una volta impostati i parametri, premere il pulsante

End (oppure Cancel per uscire senza salvare le modifiche apportate).

Un breve sunto delle impostazioni effettuate sara disponibile cliccando su LINE 1 > Report.
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* DPU - amplifiers

IMPORTANTE!

Tutti gli amplificatori collegati ad una linea devono tassativamente essere dotati di indirizzi progressivi, dal n°1 in avanti (max 16 per
linea); per impostare I'indirizzo di ogni singolo amplificatore, consultare il Capitolo “Impostazioni” sul libretto istruzioni della Serie
DPU (cod. FBT 37784).

Supponiamo di impostare sulla linea 2 il collegamento agli amplificatori Serie DPU: dopo aver premuto il pulsante LINE 2 > Configure ed aver
selezionato la voce DPU - amplifiers si apre la finestra Line 2 configuration.

In questa finestra € possibile elencare gli amplificatori (con relativi modelli) connessi alle linee in oggetto, oltre ad indicarne la valenza di
amplificatore di riserva; sono evidenziate, inoltre, le associazioni dei vari amplificatori alle riserve, cosi come selezionato in “Configurazione degli
amplificatori di riserva” (pag. 27). Il programma guida la compilazione con lo scopo di seguire alcune regole:
- Limmissione € sequenziale a partire dall'indirizzo 1. Di conseguenza, eliminando un amplificatore a meta della lista (ovvero selezionando
modello = “none”) verranno rimossi anche gli amplificatori di indirizzo successivo.
- Una linea puo gestire fino ad un massimo di due riserve: la prima riserva inserita € di tipo “globale”, ovvero pud sostituire amplificatori di
qualsiasi altra linea del controller. La seconda riserva puo essere:
* “globale” nel caso in cui nelle linee vi siano solo due riserve;
* “locale” nel caso in cui sulle linee vi siano ulteriori amplificatori. In questo caso la riserva puo sostituirsi solo ad amplificatori appartenenti
alla stessa linea della riserva.
Il programma effettua controlli incrociati per mantenere la compilazione corretta.

Una volta compilato quando desiderato, premere sul pulsante End per salvare la configurazione, che verra riportata in corrispondenza della linea
2 sulla finestra principale. In alternativa, premere Cancel per uscire senza salvare le modifiche apportate.

* VAIE 2250 - compact

Impostiamo ora sulla linea 3 il collegament o ad un sistema compatto VAIE 2250:
dopo aver premuto il pulsante LINE 3 > Configure ed aver selezionato la voce
VAIE 2250 - compact si apre la finestra Line 3 configuration.

Una volta impostati i parametri di tutte le linee, passiamo alla compilazione degli
altri quattro collegamenti riportati nella finestra principale: CTR INPUT, CTR
OUTPUT, EMERGENCY UNITS e BROADCAST UNITS.

VAIE 2000 | Voice Alarm Integrated Systems 24 Manuale di sistema | 2013



I VAC 2006 VAR 2006

e CTRINPUT

Premere sul pulsante CTR INPUT > Configure, si apre la
schermata di configurazione degli ingressi del controller 0,
dove ¢ possibile abbinare i parametri desiderati a ciascuno
dei 7 contatti.

Premere End per salvare la configurazione, oppure
Canc. per annullarla e ritornare alla schermata principale.

* CTR OUTPUT

Premere sul pulsante CTR OUTPUT > Configure, si apre la schermata
di configurazione delle uscite del controller 0, dove - come per gli ingressi
- & possibile abbinare i parametri desiderati a ciascuno dei 3 contatti.

Premere End per salvare la configurazione, oppure
Canc. per annullarla e ritornare alla schermata principale.

* EMERGENCY UNITS

Premere sul pulsante EMERGENCY UNITS > Configure, si apre
la schermata di configurazione delle postazioni d’emergenza
collegabili.

Per impostare una configurazione specifica ai tasti di ciascuna
postazione d’emergenza, premere il relativo pulsante Key Conf:
¢ possibile richiamare una configurazione gia definita (vedi par.
“Configurazione gruppi di zone”) oppure applicare manualmente
modifiche alla configurazione di default che viene proposta nel
riquadro ‘Unit key list’.
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Premere End per salvare la configurazione, oppure
Canc. per annullarla e ritornare alla schermata

principale.
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* PAGING UNITS

Premere sul pulsante PAGING UNITS > Configure, si apre la schermata
di configurazione delle postazioni di chiamata broadcast collegabili.

Perimpostare una configurazione specifica ai tasti di ciascuna postazione
d’emergenza, premere il relativo pulsante Key Conf. € possibile
richiamare una configurazione gia definita (vedi par. “Configurazione
gruppi di zone”) oppure applicare manualmente modifiche alla
configurazione di default che viene proposta nel riquadro ‘Unit key list’.
Per fare questo, selezionare nell’elenco di destra il tasto di cui si vuole
modificare I'impostazione, selezionare dall’elenco di sinistra la zona o
la configurazione che si voglio abbinare e cliccare sulle frecce centrali.
Nell’elenco di destra apparira immediatamente il nuovo abbinamento
selezionato.

Premere End per salvare la configurazione, oppure
Canc. per annullarla e ritornare alla schermata
principale.

» Configurazione gruppi di zone

Selezionare dal menu la voce View > Key configuration per aprire il prospetto completo delle zone in relazione ai controller installati nel sistema.
La schermata evidenzia con sfondo bianco il numero di unita e zone impostate; per ciascun controller sono riportate le zone attive (colore rosso).
Lo stato delle zone &€ modificabile semplicemente cliccando sul numero relativo (il numero diventa di colore verde).

Dopo averimpostato le zone desiderate, cliccare su Save per salvare la configurazione. Per creare il successivo file di configurazione, selezionarne
il nome dal menu a tendina e procedere come fatto precedentemente. Da questa finestra € possibile impostare fino a 64 file di configurazione,
che possono poi essere richiamati nelle schermate di configurazione delle postazioni (vedi paragrafi precedenti).
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* Configurazione degli amplificatori di riserva

Selezionare dal menu la voce View > Spare
configuration per aprire il prospetto completo
degli amplificatori installati nel sistema.

Nella colonna sinistra della schermata sono indicati
gli amplificatori DPU inseriti precedentemente nel
file di configurazione come riserve. Per ciascuno
di questi & possibile indicare gli amplificatori
che andranno a sostituire in caso di guasto: per
fare questo, selezionare dal menu a tendina
I'amplificatore e cliccare ‘Add’ per abbinarlo alla
riserva.

* Compilazione messaggi vocali / segnale di preavviso

Selezionare dal menu la voce View > Message Compiler per aprire la schermata che consente la gestione dei messaggi vocali pre-registrati e
dell'eventuale segnale di preavviso. Cliccare su Path > Add file e caricare il file *.wav desiderato.

Importante! | file da utilizzare devono tassativamente essere registrati e/o convertiti in formato audio *.WAV 48 ksample 16bit.

Una volta caricato il file, & possibile indicare se

si tratta di un messaggio che verra inviato in
situazioni di allerta (Alert) od evacuazione (Evac).
E inoltre possibile aggiungere una breve
descrizione di ciascun messaggio inserito (max
25 caratteri).

Oltre ai messaggi vocali, pud essere inserito con
la stessa procedura anche un tono di preavviso
(Chime).

Premere End per salvare la configurazione,
oppure chiudere la finestra per ritornare alla
schermata principale.

Una volta conclusa la configurazione del CONTROLLER 0, salvare il progetto e cliccare sul tab “CONTROLLER 1” per procedere alla
configurazione relativa.
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A questo punto la schermata principale del programma mostra la maggior parte delle impostazioni effettuate:

E possibile ottenere un report completo e stampabile di tutte le impostazioni semplicemente cliccando sui pulsanti ‘Ctr configuration report’, ‘Zone
configuration report’e ‘Spare configuration report’.

* Creazione della SD card

Una volta terminate tutte le operazioni di configurazione, € necessario riversare tutte le informazioni su una SD card che verra poi inserita nel
rispettivo controller. Dovranno essere create tante SD quanti controller presenti nel sistema: ogni card conterra le informazioni relative
al controller specifico ed al resto del sistema.

Dopo aver verificato che il CONTROLLER 0 sia spento, utilizzare un cacciavite per svitare e rimuovere il piccolo pannellino presente al centro
del pannello posteriore.

Inserire la SD nell'apposito lettore del PC e selezionare quindi la schermata del CONTROLLER 0. Dal menu principale selezionare la voce Tools
> Create SD: la scheda verra formattata e quindi automaticamente programmata con i dati necessari.

Terminata la scrittura, estrarre la SD card dal PC ed inserirla nell’apposita slot sul pannello posteriore del CONTROLLER 0; riposizionare il
pannellino di copertura e fissarlo nuovamente con le viti precedentemente rimosse.

Ripetere queste operazioni per tutti gli altri controller (nel nostro esempio, il CONTROLLER 1).
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7. STRUTTURA DEI MENU

I VAC 2006 permette I'accesso alle funzioni del sistema tramite una serie di Pannelli di Gestione raggruppati, secondo tipologia operativa e
destinazione d’uso, in Menu Opzioni accessibili dalla HOME; inoltre i seguenti Menu Opzioni sono stati assegnati a differenti livelli d’accesso,
in riferimento alle varie circostanze che richiedono diversi gradi di competenza e di autorizzazione del personale preposto.

* Menu < MUSIC >

Finestra di default per I'utilizzo del sistema nelle normali condizioni dello Stato di Quiete, permette i controlli delle sorgenti BGM e la regolazione
dei volumi della sezione musica. Il menu resta inaccessibile durante lo Stato di Allarme. In questo livello di base, i tasti RESET, ALERT e EVAC
non sono operativi.

* Menu < AUDIO SETTING >

Gruppo di opzioni di livello base per condizioni operative standard. Dedicato all’'utenza generica, per le impostazioni e le regolazioni delle sorgenti
PA. In questo livello di base, i tasti RESET, ALERT e EVAC non sono operativi.

* Menu < INSPECTION >

Primo livello d’'accesso, per ispezione dello stato del sistema. Dedicato al personale responsabile della verifica iniziale delle cause che hanno
provocato lo stato di guasto o d'emergenza. In questo livello di primo accesso, il tasto RESET ha la funzione di silenziamento del cicalino di
segnalazione FAULT. | tasti ALERT e EVAC non sono operativi.

* Menu < OPERATOR >

Secondo livello d’accesso, per il personale istruito ed autorizzato a gestire il sistema in condizioni d’'emergenza, guasto e disabilitazione.

Per accedere a questo menu € necessario inserire la password d’accesso relativa.

* Menu < CONFIGURATION >

Terzo livello d’'accesso, per il personale istruito ed autorizzato ad operare sulle funzioni avanzate del sistema e modificare i parametri di
configurazione, per avviamento e modifica impianto. Per accedere a questo menu € necessario inserire la password d’accesso relativa.

* Menu < SERVICE >

Quarto livello d’accesso, incluso nelle opzioni del menu CONFIGURATION, per le operazioni d’assistenza tecnica, aggiornamento firmware e
modifica dei parametri di funzionamento del sistema VAC 2006. Lutilizzo € consentito solo al personale di service tecnico fornito di opportuna
password d’accesso.

* Menu < EMERGENCY >

Ambiente operativo per la gestione, con priorita massima, della Emergenza Manuale. Accessibile in qualsiasi momento con il tasto espressamente
dedicato “Emergency”, deve essere utilizzato esclusivamente da personale autorizzato e opportunamente istruito sul Piano di Emergenza ed
Evacuazione (PEE).

Le funzioni legate a livelli con restrizioni d’accesso, per le quali pud essere impostata la password, verranno evidenziate dal simbolo

71 FUNZIONI “HOME” - ACCESSO Al MENU OPZIONI

711 Livello Base - Menu MUSIC

Dopo I'accensione del sistema, viene visualizzato direttamente il Pannello di gestione MUSIC. Per accedere alla HOME premere il tasto MENU, dalla
HOME si potranno selezionare i vari Menu Opzioni per le funzioni avanzate del sistema. Dalla pagina HOME premere il tasto ESC per tornare al
Pannello di gestione MUSIC.

MENU

ESC
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71.2 Livello Base - Menu AUDIO SETTING

Sulla schermata HOME, premere il tasto OK per selezionare la voce AUDIO SETTING ed accedere al menu relativo.

Dal Menu AUDIO SETTING utilizzare la manopola a lato del display per scorrere tra le opzioni elencate e selezionare quella desiderata utilizzando
il tasto OK. Premere ESC per tornare al Menu MUSIC o MENU per tornare alla HOME. Per le caratteristiche specifiche di ciascun pannello di
gestione del menu AUDIO SETTING, fare riferimento alle schede relative nella Sezione 8.3 USO DEL SISTEMA/< Menu AUDIO SETTINGS >.

71.3 Livello di Sistema - Menu INSPECTION

Sulla schermata HOME, ruotare la manopola e quindi premere il tasto OK per selezionare la voce INSPECTION ed accedere al menu relativo.
Dal Menu INSPECTION utilizzare la manopola a lato del display per scorrere tra le opzioni elencate e selezionare quella desiderata utilizzando il
tasto OK. Premere ESC per tornare al Menu MUSIC o MENU per tornare alla HOME. Per le caratteristiche specifiche di ciascun pannello di
gestione del menu INSPECTION, fare riferimento alle schede relative nella Sezione 8.4 USO DEL SISTEMA / < Menu INSPECTION >.

71.4 Livello di Sistema - Menu OPERATOR
Sulla schermata HOME, ruotare la manopola e quindi premere il tasto OK per selezionare la voce OPERATOR: per accedere al menu
relativo € necessario inserire una password e quindi premere nuovamente il tasto OK. In alternativa premere ESC per tornare al Menu
MUSIC.

Dal Menu OPERATOR utilizzare la manopola a lato del display per scorrere tra le opzioni
elencate e selezionare quella desiderata utilizzando il tasto OK. Premere ESC per tornare
al Menu MUSIC o MENU per tornare alla HOME. Per le caratteristiche specifiche di
ciascun pannello di gestione del menu OPERATOR, fare riferimento alle schede
relative nella Sezione 8.5 USO DEL SISTEMA / < Menu OPERATOR >.
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71.5 Livello di Sistema - CONFIGURAZIONE
Sulla schermata HOME, ruotare la manopola e quindi premere il tasto OK per selezionare la voce CONFIGURATION: per accedere
al menu relativo € necessario inserire una password e quindi premere nuovamente il tasto OK. In alternativa premere ESC per tornare
al Menu MUSIC.

Dal Menu CONFIGURATION utilizzare la manopola a lato del display per scorrere
tra le opzioni elencate e selezionare quella desiderata utilizzando il tasto OK.
Premere ESC per tornare al Menu MUSIC o MENU per tornare alla HOME.
Per le caratteristiche specifiche di ciascun pannello di gestione del menu
CONFIGURATION/SERVICE, fare riferimento alle schede relative nella Sezione
8.6 USO DEL SISTEMA / < Menu CONFIGURATION >.

71.6 Livello di Sistema - SERVICE
Accedere al Menu CONFIGURATION quindi utilizzare la manopola a lato del display per scorrere fino all'opzione <SERVICE> e premere
OK per selezionare: per accedere al menu relativo &€ necessario inserire una ulteriore password e quindi premere nuovamente il tasto
OK. In alternativa premere ESC per tornare al Menu MUSIC.

Le caratteristiche funzionali dei pannelli di gestione del menu
SERVICE sono di competenza del personale di servizio
tecnico ed esulano dagli scopi istruttivi del presente manuale
d’uso, pertanto non verranno di seguito illustrate.
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8. USO DEL SISTEMA

Dopo aver effettuato tutti le connessioni, rispettando le indicazioni riportate
nei paragrafi Dimensionamento e Collegamenti, avviare il VAC 2006
portando l'interruttore POWER (R1) in posizione ON; il display si illumina e
visualizza il pannello del Menu MUSIC, dal quale € possibile accedere alla
pagina HOME premendo il tasto MENU.

Se il sistema € al primo utilizzo, o sono state apportate modifiche alla
configurazione, procedere con le indicazioni riportate nella sezione
8.1 Inizializzazione dell’impianto; se invece la procedura di inizializzazione
e stata completata, continuare con le indicazioni di utilizzo riportate nelle
sezioni successive:

» Peril normale utilizzo di diffusione sonora musicale e annunci microfonici gli
utenti possono limitarsi ai menu MUSIC e AUDIO SETTING.

» Per la gestione delle funzioni avanzate in condizione di guasto, emergenza
e configurazione, consultare i successivi Menu INSPECTION, OPERATOR,
CONFIGURATION e EMERGENCY.

Per il reset del “beep” consultare la Sezione OPERATOR (par. 8.5.3.1,
pag. 49)

Per I'invio di messaggi d’emergenza consultare la sezione EMERGENZA
MANUALE (par. 8.7, pag. 54).
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Le funzioni legate a livelli con restrizioni d’accesso, per le
quali € necessaria una password, verranno evidenziate
da questo simbolo.
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8.1 INIZIALIZZAZIONE DELL'IMPIANTO

Il progetto dell'impianto audio deve essere realizzato tramite I'ausilio dell’apposito software (vedi Sezione 6. “Configurazione dell'impianto”, pag.
22).

» Password

Dalla schermata HOME selezionare il menu CONFIGURATION e confermare con OK, se la restrizione di accesso con password € abilitata,
apparira la schermata di “CONFIGURATION ACCESS”: digitare il codice a 4 cifre della password e confermare con OK (per default la password
€ 3333, vedi pag.50).

* Silenziamento BEEP
Durante la procedura di inizializzazione, possono verificarsi segnalazioni di guasto, causate dalle differenze tra la configurazione dell'impianto
collegato e i valori impostati di default. Per silenziare, di volta in volta, il tono di segnalazione acustica (beep) accedere al menu “report> FAULT”
e premere il tasto RESET. Per dettagli consultare il paragrafo “FAULT” (vedi par. 8.5.3.1, pag. 49).

o Percorso: HOME / CONFIGURATION / report> FAULT (premere tasto RESET).

* Acquisizione impedenze
Dal menu MUSIC, impostare tutte le zone di uscita con musica “OFF”. Per dettagli consultare il paragrafo “Menu MUSIC” (vedi par. 8.2.4, pag.
34).
Acquisire le nuove impedenze di carico delle linee diffusori, come indicato nel paragrafo “IMP. ACQUISITION” e abilitare i test impostando la
tolleranza di misura

o Percorso: HOME / CONFIGURATION / set> TOLERANCE | SET TOLERANCE

o Percorso: HOME / CONFIGURATION / acquire> IMPEDANCE | IMP. ACQUISITION (premere tasto OK)

 Diagnosi alimentazione 24Vcc
Se ¢ stata collegata I'alimentazione ausiliaria a 24Vcc, abilitare il test di diagnosi impostando “24Vdc P.S. ON” come da indicazioni riportate nel
paragrafo “BACKGROUND TEST” (vedi par. 8.5.2.3, pag. 48).

o Percorso: HOME / CONFIGURATION / set> BACKGROUND TEST | 4-Power supplies

» Messaggi d’emergenza
| messaggi d’emergenza sono memorizzati nella SD card tramite software dedicato (vedi pag. 27)

« Contatti d’ingresso
In base a quanto previsto dal Piano d’Emergenza ed Evacuazione (PEE) programmare opportunamente i contatti d'ingresso tramite tramite
software dedicato (vedi pag. 25).

o Percorso: HOME / CONFIGURATION / set> CONTROL INPUTS

 Contatti d’uscita
In base a quanto eventualmente previsto dalle specifiche di impianto, programmare opportunamente i contatti di uscita tramite software dedicato
(vedi pag. 25).

o Percorso: HOME / CONFIGURATION / set> CONTROL OUTPUT

* Regolazione volume
Regolare opportunamente il volume di uscita delle sorgenti d’Emergenza al fine di ottenere la migliore intelligibilita del messaggio. Il livello
impostato verra utilizzato per lo "Stato di Allarme” e sara lo stesso per tutte le zone. Per la regolazione del volume del Microfono d’emergenza e
dei messaggi ALERT ed EVAC seguire le indicazioni riportate nel paragrafo “ALARM LEVEL” (vedi par. 8.6.4, pag. 53).

o Percorso: HOME / CONFIGURATION / set> ALARM LEVEL

* Reset dei guasti
Al termine della configurazione di impianto, & opportuno cancellare le segnalazioni di guasto memorizzate e rientrate (Resumed). Effettuare
pertanto il RESET dei FAULTS come indicato nel paragrafo “FAULTS” (vedi par. 8.5.3.1, pag. 49).

o Percorso: HOME / CONFIGURATION / report> FAULT, accedere ai subpannelli di visualizzazione guasti

» Termine dell’inizializzazione
Dopo aver completato la procedura di inizializzazione impianto, effettuare il LOGOUT al fine di ripristinare I'eventuale restrizione di accesso con
password (vedi par. 8.5.5, pag. 49).

o Percorso: HOME / CONFIGURATION / Exit> Logout (premere tasto OK).
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8.2 MENU <MUsSIC>
Impostazione dei parametri audio delle sorgenti BGM
Pannello di controllo delle sorgenti musica, visualizzato dal VAC 2006 in condizioni di normale operativita dello “Stato di Quiete”.

» Tasti di navigazione

MENU: accesso al pannello HOME
OK: selezione sorgente musicale BGM
TASTI 1+6: Selezione linee

RESET: non operativo

ALERT: non operativo

EVAC: non operativo

* Indicazioni display
A) Volume generale d’uscita della sorgente BGM
B) Etichette di stato di ciascuna delle 6 linee:
OFF Musica disabilitata
ndB Musica abilitata e relativo volume d’'uscita
CALL Chiamata in corso da parte di una sorgente “voce” (sorgente PA).
NA Linea non attiva.
C) Sorgente BGM selezionata per il canale “musica’.
D) Sorgente PA attiva sul canale “voce” per annunci di servizio.

8.2.1 Selezione sorgente BGM canale “musica”

Premere il tasto OK per selezionare la sorgente musicale desiderata tra:

* AUX Sorgente a livello linea collegata alla presa LINE AUX IN (R7).

* REMOTE Sorgente selezionata dal VAC 2006 secondario tramite la presa REMOTE LINK.
* INPUT 1 Sorgente microfonica collegata all'ingresso IN 1 (R6).

* INPUT 2 Sorgente microfonica collegata allingresso IN 2 (prese LINE o MIC) (R5).

* NO INPUT Nessun ingresso selezionato.

8.2.2 Regolazione del volume generale della sorgente BGM canale “musica”

* Per regolare il volume, agire sulla manopola +/-.

Il valore di attenuazione impostato e visibile direttamente sul display (A) con variazioni di 1dB.
Il volume impostato viene memorizzato per ciascuna sorgente BGM selezionata.

8.2.3 Regolazione del volume della musica per ciascuna uscita di zona

* Tenere premuto il tasto numerico della zona desiderata (da 1 a 6) e ruotare la manopola +/-.

Il volume d’uscita € regolabile su 5 livelli d’attenuazione rispetto al volume generale master (A); i passi d’attenuazione sono:
-15dB (attenuazione massima), -9dB, -6dB, -3dB, 0dB (attenuazione nulla).

Il volume impostato é riferito esclusivamente al canale “musica”.

Nota: La regolazione non é disponibile sulle linee in cui € collegato un router VAR 2006.

8.2.4 Attivazione e disattivazione della musica per ciascuna uscita di zona
» Premere e rilasciare il tasto numerico della zona desiderata (da 1 a 6).
L'etichetta di stato (B) commutera l'indicazione tra OFF (musica disabilitata) e ndB (musica ON e relativo volume d’uscita).

Nota: Il controller VAC 2006 permette di effettuare annunci di servizio da parte di una sorgente PA sulle zone desiderate, mantenendo la
diffusione della musica sulle altre zone non interessate dalla chiamata. Durante un’annuncio in corso, il display visualizzera quale sorgente sta
impegnando il canale voce (E) e I'etichetta di stato di ciascuna zona selezionata (B) visualizzera la scritta CALL.

Gli annunci di servizio saranno diffusi al volume impostato per l'ingresso della sorgente PA (vedi menu AUDIO SETTING) e saranno
eventualmente inviati anche alle zone con musica disattivata (OFF).
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8.3 MENU < AUDIO SETTING >

Impostazione dei parametri audio delle sorgenti PA

Menu di accesso ai pannelli di gestione dei parametri riguardanti 'audio delle
sorgenti musica e voce.

Ruotando la manopola, scorrere tra le voci in elenco per selezionare la voce
desiderata e confermare premendo il tasto OK, oppure

- Premere MENU per tornare alla schermata HOME.

- Premere ESC per tornare al menu MUSICA.

Le opzioni del menu AUDIO SETTING permettono I'accesso ai seguenti pannelli:

8.3.1 set> SPEECH LEVEL
Regolazione volume delle sorgenti voce collegate al VAC 2006.

8.3.2 set> CHIME
Regolazione volume ed assegnazione alle sorgenti voce per il segnale di preavviso.

8.3.3 INPUT1
Regolazione volume ed impostazione della modalita di funzionamento dell'ingresso IN 1 (MIC.).

8.3.4 INPUT2
Regolazione volume ed impostazione della modalita di funzionamento dell'ingresso IN 2 (MIC. o LINE).

8.3.1 Set> SPEECH LEVEL
Gestione delle sorgenti voce
Pannello per I'impostazione dei livelli delle sorgenti voce collegate al VAC 2006:

1- Emerg.unit Postazioni d'emergenza Serie FMD.

2-Broad. unit Postazioni broadcast Serie MBT.

3-Mic 1 input Microfono collegato alla presa MIC 1 IN.

4-Mic 2 input Microfono collegato alla presa MIC 2 IN.

5-From remote Altri controller collegati alle prese VAC 2006 LINK.

* Regolazione del volume:
Tenere premuto il tasto numerico corrispondente alla sorgente e ruotare la manopola
+/- per regolare il volume (range -80+0 dB).

8.3.2 set> CHIME

Gestione del segnale di preavviso (din-don)
Pannello per I'impostazione del din-don che viene emesso all’attivazione di una sorgente
voce.

» Attivazione del tono di Chime:

Premere e rilasciare i tasti 2,3,4 per impostare il segnale di preavviso delle rispettive

sorgenti:

2-Emerg. unit call:  Postazioni d’'emergenza FMD 2001 e FMD 2012 per gli annunci
broadcast collegate alla presa “EMERGENCY UNITS”.

3-Brd. unit call: Postazioni microfoniche serie MBT 1106 e MBT 1112 collegate
alla presa “PAGING UNITS”

4-Preced. call: Ingressi programmati per attivare I'annuncio tramite contatto di
Precedenza o VOX.

Valori di riferimento:
ON=Chime attivo
OFF=Chime disattivo

+ Regolazione del volume tono di Chime:
Tenere premuto il tasto 1 e regolare il volume con la manopola +/- nella gamma di valori da 0 a 255; il volume € comune per i tutti gli ingressi ed
€ indipendente dalle regolazioni di volume assegnate alle sorgenti.

» Caricamento del tono di Chime:
Il file audio del Chime e gestito dal software dedicato (vedi pag. 27).
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8.3.3 set> REMOTE MUSIC

Gestione della musica verso altri controller
Pannello che consente I'abilitazione/disabilitazione della diffusione di musica
su altri controller collegati alle linee LINK A e B. Si consiglia di attivare questa
funzione su di un solo controller all'interno del sistema.

Valori di riferimento:
ON=Funzione attiva
OFF=Funzione disattiva

| tasti RESET, ALERT, EVAC, MENU ed OK non sono operativi.
Premere ESC per tornare al menu AUDIO SETTING.

8.3.4 INPUT1
Gestione della sorgente all’ingresso IN 1
Tenere premuto il tasto numerico corrispondente alla funzione e ruotare la
manopola +/- per regolare I'impostazione.
*1-Mode: impostazione della modalita di funzionamento dell’ingresso per
'impegno del canale voce come sorgente PA.
Tenere premuto il tasto 1 (Mode) e ruotare la manopola +/- per
selezionare la modalita desiderata fra le seguenti:
> On:
l'ingresso € collegato direttamente come sorgente voce ed &
operativo in base alla priorita ed alla lista zone selezionata.

> VOX lev. 1+7:

ingresso € impostato come sorgente voce a precedenza automatica attivata dalla presenza del segnale audio in ingresso.
La precedenza si attiva quando il segnale audio supera il livello di soglia impostato. Possono essere scelti fino a 7 livelli crescenti
della soglia d’intervento. La regolazione accurata della soglia permettera di ottenere una pronta diffusione del segnale, evitando
che il rumore indotto sul cavo attivi involontariamente la precedenza.

> Precedence:
l'ingresso € abilitato alla diffusione come sorgente voce tramite contatto di consenso collegato ai morsetti di precedenza.

> Off: ingresso disabilitato per funzione di annuncio PA, la sorgente collegata resta disponibile per la selezione come sorgente
BGM.

» 2-Zone call: impostazione della modalita di funzionamento dellingresso per limpegno del canale voce come sorgente PA.
Tenere premuto il tasto 2 (Zone call) e ruotare la manopola +/- per selezionare la modalita desiderata fra le seguenti:

>Z.1+2Z.216: selezione della zona specifica su cui inviare la diffusione sonora.
> All: seleziona l'invio della diffusione su tutte le zone del sistema.
>C.1+Z.64: selezione di una configurazione di gruppi di zone predeterminata (creata tramite software controller.exe) su
cui inviare la diffusione sonora.
* 3-Hold on: impostazione del tempo di rilascio, a termine del segnale in ingresso, quando viene selezionata la modalita VOX.
Tenere premuto il tasto 3 (Hold on) e ruotare la manopola +/- per scegliere la durata tra 1sec e 99sec.

» 4-Priority: priorita assegnata all'ingresso quando utilizzato come sorgente voce per annuncio di servizio. Sono disponibili 7 livelli di priorita;
l'ingresso € soggetto al muting da parte di un’altra sorgente voce a priorita superiore. Tenere premuto il tasto 4 (Priority) e ruotare
la manopola +/- per scegliere il livello desiderato.

« 5-Sensitivity: regolazione della sensibilita. Premere il tasto 5 (Sensitivity) per scegliere il livello desiderato (tra 0, 6, 12 o0 18 dB).

» 6-Phantom: Condizione impostata dell’alimentazione Phantom (OFF=disattiva / ON=attiva). Per cambiare impostazione, premere e rilasciare
il tasto 6 (Phantom).

| tasti RESET, ALERT, EVAC, MENU ed OK non sono operativi.
Premere ESC per tornare al menu AUDIO SETTING.
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8.3.4 INPUT 2
Gestione della sorgente all’ingresso IN 2
Tenere premuto il tasto numerico corrispondente alla funzione e ruotare la
manopola +/- per regolare I'impostazione.
*1-Mode: impostazione della modalita di funzionamento dell’ingresso per
I'impegno del canale voce come sorgente PA.
Tenere premuto il tasto 1 (Mode) e ruotare la manopola +/- per
selezionare la modalita desiderata fra le seguenti:
> On:
l'ingresso € collegato direttamente come sorgente voce ed &
operativo in base alla priorita ed alla lista zone selezionata.

> VOX lev. 1+7:

'ingresso € impostato come sorgente voce a precedenza automatica attivata dalla presenza del segnale audio in ingresso.
La precedenza si attiva quando il segnale audio supera il livello di soglia impostato. Possono essere scelti fino a 7 livelli crescenti
della soglia d’intervento. La regolazione accurata della soglia permettera di ottenere una pronta diffusione del segnale, evitando
che il rumore indotto sul cavo attivi involontariamente la precedenza.

> Precedence:
l'ingresso € abilitato alla diffusione come sorgente voce tramite contatto di consenso collegato ai morsetti di precedenza.

> Off: ingresso disabilitato per funzione di annuncio PA, la sorgente collegata resta disponibile per la selezione come sorgente
BGM.

» 2-Zone call: impostazione della modalita di funzionamento dellingresso per limpegno del canale voce come sorgente PA.
Tenere premuto il tasto 2 (Zone call) e ruotare la manopola +/- per selezionare la modalita desiderata fra le seguenti:

>Z.1+2Z.216: selezione della zona specifica su cui inviare la diffusione sonora.
> All: seleziona l'invio della diffusione su tutte le zone del sistema.
>C.1+Z.64: selezione di una configurazione di gruppi di zone predeterminata (creata tramite software controller.exe) su
cui inviare la diffusione sonora.
» 3-Hold on: impostazione del tempo di rilascio, a termine del segnale in ingresso, quando viene selezionata la modalita VOX.
Tenere premuto il tasto 3 (Hold on) e ruotare la manopola +/- per scegliere la durata tra 1sec e 99sec.

» 4-Priority: priorita assegnata all'ingresso quando utilizzato come sorgente voce per annuncio di servizio. Sono disponibili 7 livelli di priorita;
I'ingresso € soggetto al muting da parte di un’altra sorgente voce a priorita superiore. Tenere premuto il tasto 4 (Priority) e ruotare
la manopola +/- per scegliere il livello desiderato.

« 5-Sensitivity: regolazione della sensibilita. Premere il tasto 5 (Sensitivity) per scegliere il livello desiderato (tra 0, 6, 12 0 18 dB).

» 6-Phantom: Condizione impostata dell’alimentazione Phantom (OFF=disattiva / ON=attiva). Per cambiare impostazione, premere e rilasciare
il tasto 6 (Phantom).

| tasti RESET, ALERT, EVAC, MENU ed OK non sono operativi.
Premere ESC per tornare al menu AUDIO SETTING.
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8.4 MENU < INSPECTION >

Pannello di selezione opzioni, per ispezione dello stato del sistema. Dedicato al
personale responsabile alla verifica iniziale delle cause che hanno provocato lo
stato di guasto o d’emergenza.

Ruotando la manopola, scorrere tra le opzioni in elenco:

* report > FAULTS

* report > IMPEDANCE

* report > CONFIG.

« status > CONTROL INP.
* test > INDICATORS

< OPERATOR >

< CONFIGURATION >

Selezionare la voce desiderata premendo il tasto OK oppure

- premere ESC per tornare alla schermata MUSIC.
- premere MENU per tornare alla schermata HOME.

Le opzioni del menu INSPECTION permettono I'accesso ai seguenti pannelli di gestione:

8.4.1 pannello FAULTS (da opzione report> FAULTS)
Interrogazione sullo stato dei guasti in corso o accaduti e rientrati.

8.4.2 pannello IMP. REAL TIME (da opzione report> IMPEDANCE)

Visualizzazione delle impedenze di linea rilevate dal sistema in tempo reale, con indicazione percentuale dello scostamento dal valore

memorizzato in fase di acquisizione durante I'installazione dell'impianto.

8.43 pannello CTR CONFIGURATION (da opzione report> CONFIG)
Visualizzazione della configurazione di sistema.

8.4.4 pannello CONTROL INPUT STATUS (da opzione status> CONTROL INPUT)

Visualizzazione in tempo reale dello stato dei contatti di ingresso a bordo del VAC 2006 che possono attivare 'lEmergenza Automatica.

8.4.5 pannello INDICATORS TEST (da opzione test> INDICATORS)

Verifica della funzionalita degli elementi di segnalazione visivi e sonori per le operazioni che interessano 'emergenza (altoparlante BEEP,

display e LED).

< OPERATOR >
Passaggio diretto al menu OPERATOR vedere par. 8.5, pag. 46.

< CONFIGURATION >
Passaggio diretto al menu CONFIGURATION vedere par. 8.6, pag. 50.
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8.41 FAULTS
Visualizzazione degli elementi in guasto

Vengono elencati 6 gruppi con indicazione generica dello stato di guasto.

Le categorie degli elementi in guasto e la segnalazione generica di stato sono
riportati nella tabella sottostante.

Premere il tasto numerico (1-6) corrispondente per selezionare il sub-pannello di
opzione e visualizzare il dettaglio del guasto come da paragrafi successivi

oppure

premere ESC per tornare al pannello INSPECTION.

Etichetta Categorie di diagnosi Vedi pannello Segnalazione Causa
1-Loudspk Line Linee diffusori LOUDSPK. LINE FAULT
2-Voice Alarms Sorgenti d'emergenza VOICE ALARMS FAULT OK Nessun guasto

Amplificatori di potenza

3-Amplifiers Ground fault linee altoparlanti AMPLIFIER FAULTS =
4-Power Supply Allment.azmnl.prlma.rla e secondaria POWER SUPPLY FAULTS |:_> FAULT Almeno 1 guasto rilevato
Memoria gestione display in corso
5-Control Input Contatti d’'ingresso locali CONTROL INPUT FAULT
RES Almeno 1 guasto rientrato
6-Communication Comunicazione dati interna COMMUNICATION FAULT e nessun guasto in corso
al VAC 2006
Tab. 8.4.1.1

8.41.1 Silenziamento automatico del segnale sonoro (beep) per guasto rientrato

Quando la causa del guasto termina prima che il buzzer venga silenziato manualmente (vedi Menu OPERATOR, par. 8.5.3.1, pag. 49) il VAC
2006 spegne automaticamente il buzzer, spegne il Led FAULT e riporta la scritta RES (Resumed) nell’etichetta dell’elemento che era in FAULT
. La segnalazione di Resumed rimarra in memoria fino a quando verra effettuato il RESET MANUALE della segnalazione di guasto accedendo
al pannello FAULTS da Menu OPERATOR.
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8.41.2 LOUDSPK. LINE FAULT

Diagnosi delle linee diffusori sonori
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 1 ed accedere al
pannello di visualizzazione della diagnosi delle linee diffusori: per ciascuna
linea di uscita viene segnalato lo stato di diagnosi come da seguente

tabella.

Premere ESC per tornare al pannello FAULTS.

Etichetta

Line 1

Line 2

Line 3

Line 4

Line 5

Line 6

Nota':

Elementi in
diagnosi

Diffusori
Linea 1

Diffusori
Linea 2

Diffusori
Linea 3

Diffusori
Linea 4

Diffusori
Linea 5

Diffusori
Linea 6

TUTTI

Segnalazione
OK

Short A

Short B

Short A+B

Impedance Hi

Impedance Low

Res. imp. Hi

Res. imp. Low

VAC 2006 * VAR 2006

Causa
Nessun guasto

Corto circuito per la linea collegata all'uscita A

Corto circuito per la linea collegata all’uscita B

Corto circuito per entrambe le linee della zona
(nota’)

Impedenza rilevata con valore superiore
al valore acquisito ed oltre la tolleranza
impostata in fase di configurazione (nota?)

Impedenza rilevata con valore inferiore
al valore acquisito ed oltre la tolleranza
impostata in fase di configurazione (nota?)

Guasto rientrato per precedente segnalazione
di “Impedance Hi”

Guasto rientrato per precedente segnalazione
di “Impedance Low”

Tab. 8.4.1.2

Operazione richiesta

Eliminare il corto circuito ed
effettuare il RESET MANUALE della
segnalazione di GUASTO (da Menu
OPERATOR)

Verificare il collegamento dei diffusori
sonori ed eventualmente ripetere la
procedura d’acquisizione delle linee
(ACQUIRE IMPEDANCE)

Accedere al pannello report > FAULTS
da Menu OPERATOR ed effettuare il
RESET MANUALE della segnalazione
di GUASTO

Per azzerare lo short A+B e quindl ripristinare 'amplificatore sulla linea, € sufficiente premere i tasto RESET.

Nota’:

/guasti ‘Impedance Hi”ed “Impedance Low’non vengono segnalati se /a tolleranza di controllo impostata e superiore alla variazione dell impedenza
misurata o se Il test é disablilitato. Per dettagli sulla programmazione vedere il pannello SET TOLERANCE (par. 8.6.2, pag. 57).

8.41.3 VOICE ALARMS FAULT

Diagnosi delle sorgenti d’Emergenza
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 2 ed accedere
al pannello di visualizzazione della diagnosi delle sorgenti d’Emergenza.
Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi come da
seguente tabella.

Per accedere ai sub-pannelli, premere i tasti numerici corrispondenti.

Premere ESC per tornare al pannello FAULTS.
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Etichetta

Tutti

1-Local emerg.

2-Configuration

3-Emerg. Unit

4-Messages

5-Line connect.

6-Remote Link

Elementi in diagnosi

Tutti

Microfono palmare guasto e
Pulsante d’Emergenza

SD card

Postazioni microfoniche
d’'emergenza

Registratore/riproduttore del
Messaggio d’Emergenza di
EVACUAZIONE ed
ALLERTA

Connessione CAT5 con:
-DPU
- VAR
- AMP

Intercomunicazione con
VAC 2006 remoti
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VAC 2006 VAR 2006

Display

OK

N.T.

Res.

Fault

Fault

Fault

Fault

Fault

Fault

Causa

Nessun guasto

NO TEST. Diagnosi disabilitata
in fase di configurazione (vedi
Menu set> BACKGROUND
TEST)

Guasto rientrato per precedente
segnalazione di Fault

Microfono palmare guasto o
Pulsante d’Emergenza guasto

Errore della SD card o
Errore nella lettura dei messaggi

Almeno una postazione
microfonica d’emerg. in guasto.

Presenza di due o piu guasti.

Errore di comunicazione

Tab. 8.4.1.3
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Operazioni richieste

Accedere al pannello report> FAULTS da Menu
OPERATOR ed effettuare il RESET MANUALE
della segnalazione di GUASTO.

Verificare che il microfono sia inserito
correttamente nella presa frontale.
Se il guasto permane, contattare I'Assistenza.

Verificare che la SD card sia inserita
correttamente nell’apposito vano sul pannello
posteriore del controller.

Verificare che il microfono della postazione sia
inserito correttamente. Se il guasto permane,
contattare I'Assistenza

Verificare che la SD card sia inserita
correttamente nell’apposito vano sul pannello
posteriore del controller.

Verificare le connessioni. Se il guasto permane,
contattare I’Assistenza

Premere il tasto 6 per accedere al sub-pannello
dedicato “LINK FAULTS”. Verificare i cavi di
collegamento fra i VAC 2006 per la connessione
VAC 2006 LINK.

Se il guasto permane, contattare I'Assistenza.
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8.41.4 AMPLIFIER FAULTS

VAC 2006 * VAR 2006

Diagnosi degli amplificatori di potenza e GND fault

Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 3 ed accedere
al pannello di visualizzazione della diagnosi degli amplificatori di potenza e

ground fault linee altoparlanti.

Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi come da

seguente tabella.

Premere ESC per tornare al pannello FAULTS.

. Elementi in .
Etichetta diagnosi Display
OK
N.T.
Tutti Tutti
Res.
Amplificatori Serie DPU
. collegati al controller o
Amplifier n

Amplificatori MPA
5240/48 collegati al router

VAIE 2000 | Voice Alarm Integrated Systems

Causa

Nessun guasto

NOT TEST. Diagnosi
disabilitata in fase di
configurazione (vedi Menu
set> BACKGROUND TEST)

Guasto rientrato per
precedente segnalazione di
Fault

Amp ok

Input 20kHz

Verifica l'integrita del
collegamento tra controller ed
amplificatore

Out 20kHz
Verifica la presenza di
segnale in uscita alla linea

Gnd Fault
Verifica I'isolamento tra le
linee altoparlanti e la terra.

Tab. 8.4.1.4
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Operazioni richieste

Accedere al pannello report> FAULTS da
Menu OPERATOR ed effettuare il RESET
MANUALE della segnalazione di GUASTO.

Verificare i collegamenti tra controller,
amplificatpre e router siano effettuati
correttamente.

Se il guasto permane, contattare I'Assistenza.

Verificare che 'amplificatore sia collegato
alla rete ed acceso.
Se il guasto permane, contattare I'Assistenza.

Verificare le connessioni delle linee
altoparlanti. Se il guasto permane, contattare
I’Assistenza.
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8.41.5 POWER SUPPLY FAULTS
Diagnosi delle alimentazioni

Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 4 ed accedere
al pannello di visualizzazione della diagnosi delle alimentazioni primaria,
secondaria e della memoria di gestione del Display.

VAC 2006 VAR 2006

Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi come da

seguente tabella.

Premere ESC per tornare al pannello FAULTS.

Etichetta

Tutti

Contr. mains

Contr. 24VDC

3-Rtr/VAI mains

4-Rtr/VAI 24VDC

Ctr display
VAIE display

Elementi in diagnosi

Tutti

Alimentazione primaria
controller
@230Vca

Alimentazione
secondaria controller
@24Vce

Alimentazione primaria
router/VAIE 2250
@230Vca

Alimentazione
secondaria router/VAIE
2250 @24Vcc

Display del controller
Display del VAIE 2250
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OK

N.T.

Res.

Fault

Fault
Fault

Causa

Nessun guasto

NOT TEST. Diagnosi disabilitata
in fase di configurazione (vedi
Menu set> BACKGROUND
TEST)

Guasto rientrato per precedente
segnalazione di Fault

Alimentazione primaria del
controller non rilevata

Alimentazione secondaria
del controller non rilevata

Alimentazione primaria del
router o del VAIE 2250 non
rilevata

Alimentazione secondaria del
router o del VAIE 2250 non
rilevata

Rilevata anomalia sul display
Rilevata anomalia sul display

Tab. 8.4.1.5
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Operazioni richieste

Accedere al pannello report> FAULTS
da Menu OPERATOR ed effettuare il
RESET MANUALE della segnalazione di
GUASTO.

Controllare I'alimentazione 230Vca, il cavo
di collegamento ed il fusibile di rete.

Se il guasto permane, chiamare
I’Assistenza.

Controllare il sistema d’alimentazione
esterna a 24Vcc.

Se il guasto permane, chiamare
I’Assistenza.

Controllare I'alimentazione 230Vca, il cavo
di collegamento ed il fusibile di rete.

Se il guasto permane, chiamare
I’Assistenza.

Controllare il sistema d’alimentazione
esterna a 24Vcc.

Se il guasto permane, chiamare
'Assistenza.

Contattare I'Assistenza.
Contattare I'Assistenza.
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8.41.6 INPUT ERROR

Diagnosi degli ingressi di controllo locali

Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 5 e accedere al pannello di visualizzazione della
diagnosi degli ingressi di controllo locali. Per ogni elemento sorvegliato viene segnalato lo stato di diagnosi

come da seguente tabella. Premere ESC per tornare al pannello FAULTS.

Etichetta Elementi in diagnosi Display Causa Operazioni richieste
No input Lista Nessun‘ guasto, oppure
fault found vuota sorveghanﬁza non abilitata per alcun -
contatto d’ingresso
Verificare l'integrita della linea di collegamento
delle resistenze di bilanciamento e del contatto
d’attivazione.
. . Linea di collegamento del contatto Se il problema permane, scollegare la linea
Input in fault: . : S ) B
interrotta od in corto-circuito di collegamento d’attivazione e collegare una
Lista resistenza da 20 kQ tra i morsetti di servizio +24V e
n°ingressi l'ingresso di controllo.
Contatti d'ingresso Se il problema persiste, contattare I'Assistenza.
dat1a8
Inputs fault Guasto rientrato per precedente Accedere al pannello rep°r.t> FAULTS da Menu
resumed: segnalazione di fault OPERATOR efj effet.tuare il RESET MANUALE
della segnalazione di GUASTO.
General Input Guasto di comunicazione interna fra Se il problema persiste, contattare PAssistenza
Fault: CPU e stadio ingressi controllato ’ '
Lista
vuota

General Fault
resumed:

Guasto rientrato per precedente
segnalazione di fault

Accedere al pannello report> FAULTS da Menu
OPERATOR ed effettuare il RESET MANUALE

della segnalazione di GUASTO.

Tab. 8.4.1.6

8.4.1.7 COMMUNICATION FAULT

Diagnosi della Comunicazione dati interna al VAC 2006
Dal Pannello FAULTS (par. 8.4.1) premere il tasto numerico 6 ed accedere al pannello di visualizzazione della
diagnosi della comunicazione dati fra le sezioni interne al VAC 2006. Per ogni elemento sorvegliato viene
segnalato lo stato di diagnosi come indicato nella tabella. Premere ESC per tornare al pannello FAULTS.

Etichetta Elementi in diagnosi Display Causa Operazioni richieste
12C bus Comunicazione dati tra la CPU e tasti e Tutti Fault Guasto comunicazione interna. Chiamare I'’Assistenza.
LED del frontale
SPI Comunicazione dati tra CPU. Tutti Fault Guasto comunicazione interna. Chiamare I’Assistenza.
Tab. 8.4.1.7
8.4.2 IMP. REAL TIME | Impedenze delle linee in tempo reale

Pannello di verifica delle impedenze misurate in tempo reale, e variazione in percentuale rispetto al valore memorizzato durante I'avviamento,
tramite la procedura di “Acquisizione impedenza linee”. Vengono elencate le linee impegnate e, selezionando il tasto numerico relativo, si accede
al rispettivo pannello indicante 'impedenza misurata in ohm, riferita al parallelo delle linee A e B collegate alla linea in oggetto.

Se la percentuale di variazione supera il valore di tolleranza impostato in fase di configurazione impianto, verra segnalato il guasto “LOUDSPK
LINE FAULT” per impedenza troppo alta o troppo bassa (Impedance Hi o Impedance Low).

Premere ESC per tornare al pannello INSPECTION.

VAIE 2000 | Voice Alarm Integrated Systems 44 Manuale di sistema | 2013



I VAC 2006 * VAR 2006

8.4.3 CTR CONFIGURATION

Configurazione sistema
Pannello divisualizzazione della configurazione del sistema, nel quale viene elencata
una lista di tutte le unita presenti nel sistema, oltre all'indirizzo del controller:

Ctr address (indirizzo del controller in oggetto):
System Ctr (numero di controller nel sistema):
Emerg. unit (numero di postazioni emergenza)

0

1

1
Broad. unit (numero di postazioni broadcast) 1 6

0

0.

o =2~NO0 O,

Used ctr lines (numero di linee del controller in uso utilizzate):

confCtr v. (versione del file di configurazione del sistema) n

8.44 CONTROL INPUTS STATUS

Stato dei contatti di ingresso locali
Pannello di visualizzazione dello stato dei contatti di ingresso locali (CONTROL
INPUTS). Viene elencata la lista dei contatti di ingresso che risultano in stato di
attivazione da periferica esterna.
Il pannello CONTROL INPUT STATUS visualizza gli ingressi attivi, sia se ad essi
non € associato alcun evento, sia se in fase di configurazione € stato associato un
evento di messaggi in uscita.
Nel caso di attivazione di un CONTROL INPUT programmato, il sistema avviera
lo “Stato di Allarme”, accendera il Led ALARM e visualizzera automaticamente il
Pannello INPUT EMERGENCY che indichera quale ingresso del controller ha
attivato I'emergenza (vedi par. 8.8, pag. 56).

La funzionalita degli ingressi é definita dal firmware controller.exe.

Nota: !n casodi attivaziong contemporanea di piu contatti di.ing.resso, Priorita massima Reset generale dei messaggi (RESET)

con diversa programmazione dei messaggi sulle zone, il sistema o ) ) i )

abilitera, per ciascuna uscita di zona, 'evento associato avente la Priorita alta Messaggio pre-registrato di Evacuazione (EVAC)
priorita superiore (vedi tabella). Priorita bassa Messaggio pre-registrato di Allerta (ALERT)
Premere ESC per tornare al pannello INSPECTION. Priorita minima  Nessun evento associato (NONE)

8.4.5 INDICATORS TEST

Verifica della funzionalita degli elementi di segnalazione visivi e sonori
Pannello di verifica della funzionalita dell’altoparlante BEEP, del display e dei LED di segnalazione per le operazioni che interessano I'emergenza.
Ad eccezione del LED “ON” che rimane acceso fisso, vengono attivati in modalita lampeggiante tutti i LED del pannello frontale, compreso il
LED del tasto EMERGENCY. Viene altresi attivata una barra orizzontale che scorre su tutto il display e viene riprodotto per circa 3 secondi
il segnale sonoro BEEP di avvertimento. Verificare 'operativita dell’altoparlante a bordo, di tutti i LED e di tutti i pixel del display. In caso di
malfunzionamento contattare I'Assistenza. Premere ESC per tornare al pannello INSPECTION.
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8.5 MENU < OPERATOR >

Pannello di selezione opzioni di pertinenza del
personale istruito ed autorizzato a gestire il sistema in
condizioni d’emergenza, guasto e disabilitazione.

Se in fase di configurazione ¢ stata abilitata la password d’accesso, verra
visualizzato il pannello di OPERATOR ACCESS:

- immettere la password a 4 cifre e premere OK per procedere, oppure

- premer ESC per tornare alla HOME.

Per default la password & 2222.

Ad accesso avvenuto nel menu OPERATOR,
ruotando la manopola +/- scorrere tra le opzioni in elenco:
» set > SPEECH LEVEL

» set > BACKGROUND TEST

* report> FAULTS

* report> IMPEDANCE

* report > FAULTS

* report> CONFIG.

* status> CONTROL INP.

« test> INDICATORS

* Firmware Version

< INSPECTION >

< CONFIGURATION >

* Exit > Logout

Selezionare la voce desiderata premendo il tasto OK, oppure
- premere ESC per tornare al Pannello MUSIC,
- premere MENU per tornare alla HOME.

Le opzioni del menu OPERATOR permettono I'accesso ai seguenti pannelli di gestione:

8.5.1 pannello SPEECH LEVEL (da opzione set > SPEECH LEVEL)
Regolazione di livello delle sorgenti voce collegate al controller.

8.5.2 pannello BACKGROUND TEST (da opzione set > BACKGROUND TEST)
Abilitazione e disabilitazione dei test di sorveglianza applicati agli elementi che interessano la funzionalita del sistema in condizioni di
emergenza.

8.5.3 pannello FAULTS (da opzione report > FAULTS)
Interrogazione sullo stato dei guasti in corso, accaduti e rientrati come da stesse funzioni descritte alla sezione INSPECTION, in
aggiunta questo livello consente il RESET MANUALE DELLA SEGNALAZIONE DI GUASTO.

8.5.4 pannello FIRMWARE VERSION (da opzione Firmware Version)
Visualizzazione della versione del firmware installato nel sistema.

< INSPECTION >
Passaggio diretto al menu INSPECTION.

< CONFIGURATION >
Passaggio diretto al menu CONFIGURATION.

8.5.5 opzione Exit > Logout
Uscita dal livello di servizio e ritorno al livello base con ripristino della password di accesso.
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8.51 SPEECH LEVEL

Regolazione di livello delle sorgenti voce
Pannello per la regolazione di livello delle sorgenti voce collegate al controller
VAC 2006. Per effettuare la regolazione, premere il tasto numerico relativo alla
sorgente desiderata e ruotare la manopola +/- .

E possibile selezionare valori nel range 0 + -80dB.

Premere ESC per tornare al pannello OPERATOR.

8.5.2 BACKGROUND TEST
Impostazione dei test di sorveglianza

Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati
alle sorgenti critiche che interessano la funzionalita del sistema in condizioni
di emergenza. Vengono elencate le categorie per la scelta dell’elemento
sottoposto a diagnosi come da figura a lato.

* Premere il tasto numerico corrispondente per selezionare il sub-pannello

di opzione e visualizzare il dettaglio dell’elemento:

> 2-Voice Alarms vedere par. 8.5.2.1

> 3-Amplifiers vedere par. 8.5.2.2

> 4-Power Supply  vedere par. 8.5.2.3

> 5-Control Input  vedere par. 8.5.2.4

> 6-Communication vedere par. 8.5.2.5
oppure
premere ESC per tornare al pannello OPERATOR.

8.5.21 VOICE ALARMS
Impostazione dei test per sorgenti d’emergenza
Pannello di abilitazione e disabilitazione dei test di sorveglianza.

* Premere il tasto numerico corrispondente per selezionare la voce
desiderata per aprire il sub-menu e quindi per abilitare o disabilitare il test
di diagnosi (on = test abilitato / off = test disabilitato):

> 1-Local Emerg. > 1-Microphone
> 2-Emerg. button

> 2-Configuration > 1-SD card
> 2-Msg table

> 3-Emerg. Unit > 1-Ctr unit <1>

> 4-Messages > 1-Evac message
> 2-Alert message

> 5-Line connect. > 1+6-Line n connect.

> 6-Remote Link: > 1-Remote link A
> 2-Remote link B
> 3-Remote ctr

Nota: il display visualizza lo stato di programmazione impostato.
Premere ESC per tornare al pannello BACKGROUND TEST.
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8.5.2.2 AMPLIFIERS

Impostazione dei test per amplificatori
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati
agli amplifcatori voce e musica.

* Premere il tasto numerico corrispondente per abilitare o
disabilitare il test di diagnosi (on = test abilitato / off = test disabilitato):

> 1-Ampli Line 1 (on = test abilitato / off = test disabilitato)
> 2-Ampli Line 2 (on = test abilitato / off = test disabilitato)

Nota. il display visualizza lo stafo di programmazione impostato.
Premere ESC per tornare al pannello BACKGROUND TEST.

8.5.2.3 POWER SUPPLY

Impostazione dei test per alimentazioni
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati
all'alimentazione primaria 230Vca, all’alimentazione secondaria 24Vcc.

* Premere il tasto numerico corrispondente per abilitare o
disabilitare il test di diagnosi:

> 1-Mains P.S. (on = test abilitato / off = test disabilitato)
> 2-24Vdc P.S. (on = test abilitato / off = test disabilitato)
> 4-Display (on = test abilitato / off = test disabilitato)

Nota. il display visualizza lo stafo di programmazione impostato.
Premere ESC per tornare al pannello BACKGROUND TEST.

8.5.2.4 CONTROL INPUT
Impostazione test per ingressi controllati
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati
agli ingressi controllati.
» Premere il tasto numerico corrispondente per abilitare o
disabilitare il test di diagnosi:

> 1-Controller IN (on = test abilitato / off = test disabilitato)
> 2-Rtr/PAIN (on = test abilitato / off = test disabilitato)

Nota. il display visualizza lo stafo di programmazione impostato.
Premere ESC per tornare al pannello BACKGROUND TEST.

8.5.2.5 COMMUNICATION

Impostazione test per comunicazione interna dati
Pannello di abilitazione e disabilitazione dei test di sorveglianza applicati
alla comunicazione dei dati fra le sezioni interne al VAC 2006.

* Premere il tasto numerico corrispondente per abilitare o
disabilitare il test di diagnosi:

> 1-Communication (on = test abilitato / off = test disabilitato)

Nota. il display visualizza lo stafo di programmazione impostato.
Premere ESC per tornare al pannello BACKGROUND TEST.
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8.5.3 FAULTS
Visualizzazione guasti (da menu OPERATOR)

I menu OPERATOR consente I'accesso al pannello “FAULTS” come da
caratteristiche illustrate nella stessa sezione del menu <INSPECTION>. La
funzionalita aggiuntiva consentita accedendo al pannello “report> FAULTS”

dal livello OPERATOR ¢ il “Reset manuale della segnalazione di guasto”.

8.5.3.1 Reset manuale della segnalazione di guasto (RES)
Il Reset Manuale & necessario nei seguenti casi:

* Per cancellare la segnalazione memorizzata di RES (Resumed), in caso
di guasto rilevato e successivamente risolto, per tutti gli altri elementi

sorvegliati.
* Per ammutolire il buzzer.

Per effettuare il RESET MANUALE DELLA SEGNALAZIONE DI GUASTO, dal pannello di visualizzazione generale FAULTS.

* Premere il tasto RESET

Al termine della procedura premere ripetutamente il tasto ESC per tornare al menu OPERATOR.

8.5.4 FIRMWARE VERSION

Visualizzazione della versione del Firmware
Pannello di visualizzazione della versione del firmware installato nel sistema.
Vengono indicati i firmware delle 3 seguenti sezioni:

> Units software

Software principale installato sulla CPU per la gestione delle unita.
> Zones software

Software principale installato sulla CPU per la gestione delle zone.
> Matrix firmware

Firmware di gestione dei segnali audio.

8.5.5 Exit > Logout

Uscita dal livello di Sistema
Al temine delle operazioni svolte, prima di tornare al Livello Base del Menu
MUSIC, & opportuno eseguire il Logout dal Livello di Sistema del Menu
in corso, al fine di ripristinare la password di richiesta per i futuri accessi,
e impedire che il personale non autorizzato possa accedere alle funzioni
avanzate del sistema.

Dall’elenco opzioni del MENU OPERATOR:
* ruotare la manopola +/- per selezionare I'opzione
Exit> Logout
» premere il tasto OK
Il sistema torna al Livello Base e visualizza il pannello del Menu MUSIC.

La richiesta della password di accesso sara ripristinata anche per gli altri
livelli che eventualmente erano stati visitati.
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8.6 MENU < CONFIGURATION >

Pannello di selezione opzioni di pertinenza del personale
espressamente istruito ed autorizzato ad operare sulle funzioni
avanzate del sistema e modificare i parametri di configurazione,
ai fini di avviamento e manutenzione impianto. Puo essere
aggiunta una password d’accesso.

Se in fase di configurazione ¢ stata abilitata la password d’accesso, verra
visualizzato il pannello di CONFIGURATION ACCESS:

- immettere la password a 4 cifre e premere OK per procedere, oppure

- premere ESC per tornare alla HOME.

Per default, la password d’accesso € 3333.

Ad accesso avvenuto nel menu CONFIGURATION saranno elencate
tutte le opzioni precedentemente illustrate nei Menu “AUDIO SETTING”,
“INSPECTION” e “CONFIGURATION” e le seguenti nuove opzioni dello
specifico menu CONFIGURATION:

ruotando la manopola, scorrere tra le opzioni in elenco
* acquire > IMPEDANCE
 set > IMP. TOLERANCE

» set > 20KHZ LEVELS

» set > ALARM LEVEL

» set > SPEECH LEVEL

* set> AMP SET TIME

» set > BACKGROUND TEST
* set > CHIME

* report > FAULTS

* report > IMPEDANCE

« status > CONTROL INP.

« test > INDICATORS

INPUT 1

INPUT 2

Firmware Version

Password

Beep operation

< SERVICE >

» Exit > Logout

Selezionare la voce desiderata premendo il tasto OK, oppure
- premere ESC per tornare al Pannello MUSIC.
- premere MENU per tornare alla HOME.

Nei paragrafi successivi verranno illustrate le caratteristiche dei pannelli specifici del menu CONFIGURATION, per le altre opzioni disponibili fare
riferimento a quanto illustrato nelle relative sezioni precedenti.
Al termine delle operazioni di configurazione, effettuare il logout selezionando “Exit> Logout” come descritto al paragrafo 8.5.5, pag. 49.

Le opzioni del menu CONFIGURATION permettono I'accesso ai seguenti pannelli di gestione:
8.6.1 pannello ACQUIRE IMPEDANCE (da opzione acquire > IMPEDANCE)
Acquisizione e memorizzazione delle impedenze delle linee diffusori sonori. Necessario per l'inizializzazione e diagnosi del sistema.

8.6.2 pannello SET TOLERANCE (da opzione set > IMP. TOLERANCE)

Impostazione della tolleranza di controllo dell'impedenza delle linee. Quando il sistema di diagnosi rileva un’impedenza di valore oltre la
tolleranza consentita, viene attivato lo “Stato di Guasto” (Fault Warning Condition).

8.6.3 pannello 20KHZ LEVEL SETTINGS (da opzione set > 20KHZ LEVELS)

Impostazione dei livelli di segnale di test a 20kHz nei vari canali audio.

8.6.4 pannello ALARM LEVEL (da opzione set > ALARM LEVEL)
Pannello per la regolazione del volume di uscita delle sorgenti d’Emergenza: Microfoni di Emergenza e Messaggi di Allarme.

8.6.5 pannello AMPLIFIER TEST TIME (da opzione set > AMP SET TIME)
Impostazione dell’intervallo tra un test e I'altro negli amplificatori DPU.

8.6.6 pannello PASSWORD (da opzione Password)
Pannello di abilitazione, disabilitazione e personalizzazione della password di accesso ai livelli di servizio del sistema.

8.6.7 pannello BEEP OPERATION (da opzione Beep operation)
Pannello di abilitazione, disabilitazione e personalizzazione del ‘beep’ di sistema.

< SERVICE > Collegamento al menu SERVICE dedicato al personale tecnico fornito di opportuna chiave d’accesso, per la modifica dei

parametri di funzionamento del sistema VAC 2006, aggiornamento firmware e assistenza tecnica.
Nota: /e impostazioni del menu Service non verranno trattate nel presente Manuale.

VAIE 2000 | Voice Alarm Integrated Systems 50 Manuale di sistema | 2013



I VAC 2006 VAR 2006

8.6.1 ACQUIRE IMPEDANCE

Acquisizione delle impedenze di linea
Pannello per I'acquisizione e memorizzazione delle impedenze delle linee
diffusori sonori. Necessario per l'inizializzazione e diagnosi del sistema.

8.6.1.1 Acquisizione delle impedenze delle linee diffusori

Premessa

Prima di procedere con l'acquisizione delle impedenze accertarsi di aver

completato i seguenti passi:

« Controllo preventivo dellimpedenza delle linee con idoneo strumento di
misura (IMPEDENZIMETRO) e verifica delle condizioni di carico.

« Collegamento delle linee dei diffusori sonori come indicato nella sezione
4. CONNESSIONI.

Dopo aver selezionato I'opzione “acquire> IMPEDANCE” dal Menu CONFIGURATION, il pannello “ACQUIRE IMPEDANCE” visualizza le
impedenze memorizzate nell’ultima acquisizione delle linee:

» premere il tasto OK

Le nuove impedenze acquisite vengono automaticamente memorizzate nel sistema e riportate nell’etichetta di ciascuna zona; I'indicazione del
valore € in ohm e si riferisce al parallelo di entrambe le linee A e B collegate all’'uscita di ciascuna zona.

| valori di impedenza residenti in memoria, saranno confrontati dal sistema di sorveglianza con i valori successivamente misurati nella routine di
diagnosi.

Nota: Per misurare I'impedenza delle linee dei diffusori sonori, il sistema di sorveglianza previsto nel VAC 2006 utilizza un tono inudibile a 20kHz; a causa
dell'induttanza della bobina degli altoparlanti, impedenza riferita a 20kHz* potra essere notevolmente diversa da quella misurata con I'impedenzimetro
il quale, generalmente, utilizza un tono di misura a 1kHz. Pertanto il valore acquisito dal VAC 2006 e indicativo solo come confronto per la diagnosi e
si consiglia, invece, di attenersi al valore misurato con I'impedenzimetro per il calcolo della potenza assorbita dalle linee dei diffusori sonori ai fini del
dimensionamento dellimpianto.

* Gli amplificatori della Serie DPU utilizzano un tono a 30Hz.
Premere ESC per tornare al menu CONFIGURATION.
Al termine della procedura, effettuare il RESET MANUALE DELLA SEGNALAZIONE DI GUASTO come descritto nel par. 8.5.3.1, pag. 49.

8.6.2 SET TOLERANCE
Impostazione della tolleranza di controllo linee

Pannello per I'impostazione della tolleranza di controllo della impedenza
delle linee. Nel caso in cui il sistema di diagnosi, nel confronto fra
'impedenza misurata in tempo reale e quella memorizzata nel sistema, rilevi
una variazione superiore alla tolleranza impostata: verra attivato lo “Stato
di Guasto” (Fault Warning Condition) PER GUASTO “Impedance Low” o
“Impedance Hi”. Per dettagli sulla segnalazione di guasto, vedi pannello
“LOUDSPK. LINE FAULT” (par. 8.4.1, pag. 40).

8.6.2.1 Impostazione della tolleranza di misura delle linee
Premessa: L'impostazione della tolleranza di misura dovra essere fatta dopo
aver completato I'acquisizione delle impedenze di linea (vedi par.8.6.1).

Il valore di default & 30%.

Dopo aver selezionato I'opzione “set> IMP. TOLERANCE” dal Menu
CONFIGURATION, il pannello “SET TOLERANCE” visualizza le tolleranze
attualmente impostate per ciascuna zona di uscita.
* premere il tasto numerico della linea relativa
« tenere premuto il tasto numerico della zona relativa (1+6)
ruotando la manopola +/- per scegliere il valore desiderato.

>Valori da 10% a 100%: tolleranza di variazione in + e in - rispetto al
valore memorizzato

>Test Disabled: controllo del'impedenza disabilitato. Verra comunque
effettuato il test delle linee per corto circuito e GND fault.

E possibile inoltre disabilitare il test del'impedenza impostando la tolleran-
za a 0% (Not Tested).

Premere ESC per tornare al menu CONFIGURATION.

Al termine della procedura, effettuare eventualmente il RESET MANUALE
DELLA SEGNALAZIONE DI GUASTO come descritto nel par.8.5.3.1, pag.
49.
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8.6.3 20KHZ LEVEL SETTINGS
Impostazioni di livello 20kHz

Pannello per I'mpostazione dei livelli di segnale di test a 20kHz nei vari canali
audio del controller VAC 2006.

> 1-Master level
Livello generale del livello di test a 20kHz.

* Premere il tasto 1 e ruotare la manopola +/-

> 2-Link music lev.
Livelli di uscita segnale musica a 20kHz inviato verso gli altri controller collegati.
> 1-Link Alevel >Premere tasto 1 e ruotare la manopola +/-

> 2-Link B level >Premere tasto 2 e ruotare la manopola +/-

> 3-Link speech lev.

Livelli di uscita segnale voce a 20kHz inviato verso gli altri controller collegati.
> 1-Link A level >Premere tasto 1 e ruotare la manopola +/-
> 2-Link B level >Premere tasto 2 e ruotare la manopola +/-

> 4-Line music lev.

Livelli di test del canale musica.
> 1-Line 1 level >Premere tasto 1 e ruotare la manopola +/-
> 2-Line 2 level >Premere tasto 2 e ruotare la manopola +/-
> 3-Line 3 level >Premere tasto 3 e ruotare la manopola +/-
> 4-Line 4 level >Premere tasto 4 e ruotare la manopola +/-
> 5-Line 5 level >Premere tasto 5 e ruotare la manopola +/-
> 6-Line 6 level >Premere tasto 6 e ruotare la manopola +/-

> 5-Line speech lev.

Livelli di test del canale voce.
> 1-Line 1 level >Premere tasto 1 e ruotare la manopola +/-
> 2-Line 2 level >Premere tasto 2 e ruotare la manopola +/-
> 3-Line 2 level >Premere tasto 3 e ruotare la manopola +/-
> 4-Line 2 level >Premere tasto 4 e ruotare la manopola +/-
> 5-Line 2 level >Premere tasto 5 e ruotare la manopola +/-
> 6-Line 2 level >Premere tasto 6 e ruotare la manopola +/-

Nota. il display visualizza lo stafto di programmazione impostato in fabbrica.

Premere ESC per tornare al pannello 20KHZ LEVEL SETTINGS.
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8.6.4 ALARM LEVEL
Regolazione del volume delle sorgenti d’emergenza
Pannello per la regolazione del volume di uscita delle sorgenti d’emergenza ai fini di
taratura del sistema.
Per regolare il volume della sorgente desiderata:
« tenere premuto il tasto numerico corrispondente (1 + 5)
e
* regolare il volume con la manopola +/-.
Nota: Il volume impostato sara lo stesso per tutte le linee di uscita.

Al termine dell’operazione premere ESC per tornare al menu CONFIGURATION.

1-Volume d’uscita delle postazioni microfoniche d’emergenza FMD collegate alla propria unita VAC 2006 locale: il range di regolazione per
EMERGENCY UNITS e compreso fra-80 dB e 0 dB.

2-Volume d’uscita del microfono palmare d’emergenza: il range di regolazione per FIRE MICROPHONE & compreso fra -80 dB e 0 dB.
S/ suggerisce per la maggior parte dei casi di non superare il valore di +16 dBb.

3-Volume d’uscita del messaggio preregistrato d’ALLERTA: Il range di regolazione per ALERT MESSAGE & compreso fra -80 dB e 0 dB.

4-Volume d’uscita del messaggio preregistrato d’EVACUAZIONE: Il range di regolazione per EVAC MESSAGE & compreso fra -80 dB e 0
dB.

5-Volume del segnale d’emergenza proveniente da controller VAC 2006 remoto: il range di regolazione per VAC 2006 LINK € compreso fra -80
dB e 0 dB.

8.6.5 AMPLIFIER TEST TIME
Impostazione dell’intervallo di test degli amplificatori Serie DPU
* Tenere premuto il tasto numerico corrispondente (1 + 3) e regolare ed impostare
tramite la manopola +/-:
1-Line Linea (1+6)
2-Amp  Amplificatore (1+16/ALL)
3-Time Duratadeltest (5s+ 18h/no test)

Al termine dell'operazione premere ESC per tornare al menu CONFIGURATION.

8.6.6 PASSWORD
Impostazione del codice password
Pannello di abilitazione, disabilitazione e personalizzazione della password di
accesso ai livelli di servizio del sistema.
» Con la manopola +/- posizionare il cursore sui numeri corrispondenti alla
password da modificare.
» Utilizzare i tasti numerici (1+6) per scrivere la nuova password.
» Premere il tasto OK per abilitare o disabilitare la password impostata.

Nota: il display visualizza lo stato di programmazione impostato.

8.6.7 BEEP OPERATION
Gestione del “beep” di sistema
Pannello di abilitazione e disabilitazione del “beep” di sistema.
» Utilizzare il tasto 1 per abilitare o disabilitare 'emissione del segnale sonoro.
Nota: il display visualizza lo stato di programmazione impostato.

Al termine dell'operazione premere ESC per tornare al menu CONFIGURATION.
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8.7 EMERGENZA MANUALE - Menu < EMERGENCY >
Di seguito verra descritta la procedura per la gestione delle emergenze con intervento manuale da parte di operatore
autorizzato.

8.7.1 Informazioni generali

L'emergenza manuale & accessibile in qualunque momento, ha la priorita sui messaggi pre-registrati eventualmente in corso, attivati dalla
periferica esterna collegata agli ingressi di controllo “CONTROL INPUTS” e sulle eventuali postazioni d’emergenza che hanno facolta di operare
sulle 6 linee d'uscita del controller in uso.

8.7.2 Gestione manuale dell’emergenza

Il controller VAC 2006, grazie al funzionamento a doppio canale, consente un gestione articolata dei messaggi di allarme, del silenziamento
degli stessi e della selezione delle zone come approfondito nei paragrafi successivi, di seguito viene riportato un elenco di operazioni per un
rapido approccio all'emergenza manuale.

A) Invio dell’emergenza dal controller

- Premere 1 volta il tasto EMERGENCY, che si accende in modo
fisso. L'avvenuta messa in stato d’emergenza viene visualizzata
anche su router, postazioni ed eventuali controller collegati.

- Inviare un messaggio vocale (tramite il microfono palmare) o
messaggio d’allerta (tasto ALERT) o messaggio d’evacuazione
(tasto EVAC) su tutte le zone.

Il display visualizza la tipologia di messaggio in corso.

Nota: il messaggio inviato tramite microfono palmare ha
priorita assoluta su evacuazione ed allerta pre-registrati.

Per terminare i messaggi d’'emergenza in vivavoce, i messaggi d’allerta e/o evacuazione, premere nuovamente il pulsante EMERGENCY.

B) Invio dell’emergenza da postazioni remote Serie FMD

- Sollevare il coperchietto di sicurezza sulla postazione e premere 1 volta il pulsante EMERGENCY, che si accende in modo fisso. L'avvenuta
messa in stato d’emergenza da parte della postazione viene visualizzata anche su router e sul/i controller collegati tramite display e tasto
lampeggiante.

- Selezionare le zone dove si desidera inviare il messaggio

- Parlare al microfono tenendo premuto il tasto P.T.T. fino al termine del messaggio.

Nota: Il tasto P.T.T. ha la priorita su eventuali messaggi pre-registrati in corso.

Per terminare il messaggio d’'emergenza in vivavoce, rilasciare il pulsante P.T.T. e premere nuovamente il pulsante EMERGENCY, avendo cura
di richiudere lo sportellino.

* Invio di messaggi d’allerta e/o evacuazione pre-registrati

- Selezionare le zone dove si desidera inviare il messaggio.

- Premere il tasto ALERT (allerta) od EVAC (evacuazione) per
inviare i messaggi pre-registrati sulle zone selezionate.

Per terminare il messaggio d’emergenza in vivavoce, rilasciare |l
pulsante P.T.T. e premere nuovamente il pulsante EMERGENCY,
avendo cura di richiudere lo sportellino.
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C) USCITA DEL SISTEMA DALLA GESTIONE MANUALE DELL’EMERGENZA
Al termine della procedura di gestione dellEmergenza Manuale, premere il tasto rosso EMERGENCY, che si spegnera e:

- Se non ci sono attivazioni in corso da periferiche esterne collegate ai contatti d’ingresso “Control Inputs”, il sistema ritorna automaticamente
allo stato di Riposo visualizzando il Menu <MUSIC>. Il Led ALARM resta spento ad indicare la condizione di VOICE ALARM disattiva.

- Se ci sono aftivazioni in corso da periferiche esterme collegate ai contatti di ingresso “Control Inputs™
il sistema ritorna allo stato di Emergenza Automatica, visualizzando il Menu INPUT ALARM STATUS e riprendendo la diffusione dei messaggi
di emergenza in base alla programmazione prevista per gli ingressi attivati, con eventuale Led ALARM acceso ad indicare la condizione di

VOICE ALARM attiva.
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8.8 EMERGENZA AUTOMATICA - Stato di allarme attivato da periferica esterna
Di seguito verra descritta la modalita operativa del sistema in caso di Emergenza automatica avviata da periferica esterna che attiva i contatti
di ingresso programmati per abilitare lo “Stato di Allarme”.

8.81 Attivazione dell’emergenza automatica

Nel caso di attivazione di un contatto di ingresso locale programmato, il
controller VAC 2006 interrompe la normale attivita dello “Stato di Quiete”,
silenzia la musica in diffusione, blocca la funzionalita delle sorgenti PA per
annunci broadcast e visualizza il pannello “INPUT EMERGENCY” che indica
nello specifico quale ingresso esterno ha attivato 'emergenza.

Se il contatto & stato programmato per inviare almeno un messaggio di
emergenza su almeno una zona d'uscita, il sistema avvia 'Emergenza
Automatica abilitando lo “Stato di Allarme” (VOICE ALARM) e accendendo il
Led ALARM. Il pannello INPUT EMERGENCY riportera il tipo di messaggio
pre-registrato presente in uscita su ciascuna linea.

Visualizzazione dello stato operativo

LED ALARM: led acceso che segnala la condizione di VOICE ALARM attiva
quando € presente I'annuncio microfonico a viva-voce o il messaggio pre-
registrato in corso, in uscita su almeno una zona.

Barra di stato delle linee

- Etichetta vuota: zona senza messaggio in corso.

- RESET: zona muta per contatto di reset generale.

- EVAC: zona con messaggio di EVACUAZIONE in corso.

- ALERT: zona con messaggio di ALLERTA in corso.

- DIS: zona disabilitata dagli allarmi.

- FAIL: zona in condizione di guasto della linea diffusori. Etichetta visualizzata anche se il tipo di guasto non compromette la diffusione del
segnale in uscita. Nella condizione di funzionamento a singolo canale, per guasto amplificatore, indica che la zona non puo diffondere il
segnale previsto.

8.8.2 Operativita del sistema durante I’emergenza automatica
Fino a quando i contatti di ingresso rimangono attivi, il pannello MUSIC rimane disattivato, & possibile tuttavia navigare fra i vari menu di opzione per
accedere alle funzioni avanzate del sistema e ispezionare o modificare le impostazioni.

- Lo “Stato di Allarme” in corso per emergenza automatica puo essere modificato dall’operatore autorizzato che interviene sul sistema per attivare i
controlli manuali di gestione dell’emergenza, al fine di silenziare i messaggi (RESET), cambiare i messaggi in corso o inviare annunci a viva-voce con
il microfono predisposto.

Per dettagli sulla gestione del’emergenza manuale consultare la sezione EMERGENZA MANUALE, par. 8.7, pag. 54.
8.8.3 Uscita dall’Emergenza Automatica
« Disattivare il contatto che ha attivato 'emergenza
o

» Premere il pulsante EMERGENCY e tenere premuto per almeno 2 secondi il tasto RESET e rilasciarlo.

Al fine di segnalare all'operatore che I'attivazione dell’allarme proviene da contatti esterni, il controller mantiene visualizzato sul display I'avviso dell’avvenuta
emergenza (lampeggiante).

I sistema torna allo Stato di Quiete visualizzando il pannello MUSIC.
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9. STATO DI GUASTO

Il controller VAC 2006 dispone di una routine di diagnostica che monitora continuamente la disponibilita delle sorgenti d’emergenza, e I'integrita
del percorso critico dei segnali adibiti alla funzionalita in condizioni di emergenza.

9.1 OPERATIVITA E SEGNALAZIONI DEL SISTEMA IN CONDIZIONE DI GUASTO GENERICO

9.1.1 Segnalazione del sistema per “Stato di Guasto” in corso

Quando il sistema di sorveglianza, durante la normale operativita dello “Stato di Quiete”, rileva una causa di guasto, attiva tempestivamente la
segnalazione dello “Stato di Guasto” come segue:

» accensione del Led FAULT (segnalazione visiva).

» accensione del BEEP sull'altoparlante monitor (segnalazione sonora).

« attivazione dei contatti di uscita locali CONTROL OUTPUTS eventualmente programmati (segnalazione remota).

» visualizzazione della condizione di guasto (FAULT) nell’etichetta di stato del pannello di Report FAULT.

9.1.2 Segnalazione del sistema per “Stato di Guasto” rientrato (RES)

Se la causa del guasto rientra automaticamente, senza alcun intervento dell’operatore, il sistema ritorna automaticamente allo “Stato di Quiete”,
disattivando tutte le segnalazioni sopra descritte e mantenendo in memoria 'ultimo guasto occorso mediante:

» visualizzazione della scritta RES nell’etichetta di stato del pannello Report FAULT per Guasto Rientrato (Resumed).

9.1.3 Cancellazione della Segnalazione di Guasto rientrato (RESET FAULT)

Per cancellare la segnalazione del guasto memorizzato e non piu in corso:

» accedere al pannello FAULTS dal menu OPERATOR (vedi par. 8.5.3, pag. 49)

» effettuare il RESET MANUALE della segnalazione di guasto come indicato al par. 8.5.3.1, pag. 49.

Nota: in caso di guasto della linea diffusori sonori per corto circuito (Short), quando la linea viene riparata, & necessario effettuare il RESET MANUALE
DEL GUASTO da menu Operator, al fine di riattivare il segnale audio sull’'uscita della linea interessata.

9.1.4 Procedura suggerita in condizione di guasto in corso

La procedura con “stato di Guasto” in corso € la seguente:

» accedere al pannello FAULTS dal menu INSPECTION (vedi par. 8.4.1, pag. 39)

» verificare qual € la categoria di diagnosi in FAULT ed accedere al sub-pannello specifico.

» verificare la causa del guasto e, se possibile, ripristinare la corretta operativita seguendo le operazioni richieste nella tabella riferita al sub-
pannello (vedi par. da 8.4.1.2 a 8.4.1.7).

Se il ripristino del’lanomalia &€ andato a buon fine, il termine della condizione di Guasto viene segnalato come segue:

» spegnimento del Led FAULT

+ disattivazione dell’eventuale contatto di uscita

» visualizzazione della scritta RES nell’etichetta di stato del pannello Report FAULT per Guasto Rientrato (Resumed)

A completamento della procedura € opportuno cancellare la segnalazione del guasto memorizzato e non piu in corso (vedi par. 9.1.3).

9.2 OPERATIVITA E SEGNALAZIONI DEL SISTEMA IN CONDIZIONE DI GUASTO LINEA DIFFUSORI

Il guasto della linea diffusori pud essere dovuto a varie cause, le modalita di segnalazione e le operazioni richieste sono descritte nel par. 8.4.1.2
Pannello LOUDSPK. LINE FAULT. Se si tratta di una variazione di impedenza, il VAC 2006 continua a diffondere il segnale audio in uscita della
zona, se si tratta di un corto circuito della linea, il sistema scollega la linea in guasto e diffonde il segnale audio sull’altra linea integra della stessa
zona.
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CARATTERISTICHE TECNICHE
Display

Ingressi

USB-EXT.

Microfono d’emergenza

« Sensibilita / Impedenza
« Risposta in frequenza / Rapporto S/N

IN.1

Presa (MIC.)

« Sensibilita / Impedenza

« Risposta in frequenza / Rapporto S/N

IN.2

Presa (MIC.)

« Sensibilita / Impedenza

« Risposta in frequenza / Rapporto S/N
Presa (LINE)

« Sensibilita / Impedenza

« Risposta in frequenza / Rapporto S/N

AUX
« Sensibilita / Impedenza
« Risposta in frequenza / Rapporto S/N

Paging units
« Sensibilita / Impedenza
« Risposta in frequenza / Rapporto S/N

EMERGENCY UNITS
Uscite

SLAVE LINK OUTPUT
« Livello d’'uscita/ Impedenza

VAC 2006 LINK
« Livello d'uscita/ Impedenza
« Sensibilita / Impedenza d’ingresso

Controlli d’emergenza
« Ingressi CONTROL INPUTS
 Uscite CONTROL OUTPUTS

PrecedenzaIN 1 -IN 2
LAN
Generalita

Alimentazione da rete @230Vca
Consumo @230Vca

Alimentazione esterna in corrente continua @24Vcc
Consumo @24Vcc

Condizioni ambientali operative
Montaggio

Dimensioni prodotto (L x A x P)
Dimensioni imballo (L x A x P)

Peso netto
Peso lordo

CARATTERISTICHE TECNICHE

Alimentazione da rete @230Vca
Consumo @230Vca

Alimentazione esterna in corrente continua @24Vcc
Consumo @24Vcc

Massima potenza commutabile per singola zona
Condizioni ambientali operative
Montaggio

Dimensioni prodotto (L x A x P)
Dimensioni imballo (L x A x P)

Peso netto
Peso lordo
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VAC 2006 * VAR 2006

VAC 2006

3” retroilluminato 128x64 punti

Ingresso USB alimentato sul frontale - Presa tipo A

Bilanciato XLR-F su frontale

Livello segnale 20 mV / 10 kQ

60 +20.000 Hz /72 dB

Programmabile per modalita ON / OFF / Precedenza / VOX con A.P.T.
Bilanciato XLR-F (con alimentazione Phantom 24V inseribile)

Livello segnale Min. 3 mV - Max 100 mV / 1,8 kQ

240 +20.000 Hz / 63 dB

Programmabile per modalita ON/ OFF / Precedenza / VOX con A.P.T.
Bilanciato XLR-F (con alimentazione Phantom 24V inseribile)

Livello segnale Min. 3 mV - Max 100 mV / 1,8 kQ

240 +20.000 Hz /63 dB

Bilanciato a morsetti (HOT-COM-GND)

Livello segnale Max 1800 mV / 31 kQ

60 +20.000 Hz/ 84 dB

Presa stereo RCA per sorgente sonora (BGM) - Conversione in monofonia
Livello segnale Max 1800 mV / 31 kQ
60 +20.000 Hz/ 84 dB

2 Rj45 per unita di chiamata (PA) Serie MBT 1106/MBT 1112.
Livello segnale Max 1400 mV / 85 kQ
60 +20.000 Hz/ 83 dB

Rj45 per collegamento a postazione microfonica d’emergenza dedicata.

Rj45 per collegamento ad unita VAR 2006 / DPU / VAIE 2250
Max 2000 mV /400 Q

Rj45 per collegamento ad unita VAC 2006
Max 2000 mV /400 Q
2000 mV / 50 kQ

Programmabili per stato normalmente attivo o normalmente disattivo.
7 ingressi con diagnosi.
3 relé per segnalazione stato d’'emergenza e guasto, morsetti N.O-N.C.-Scambio.

Ingresso precedenza a morsetti con comune +12 Vcc.

Presa LAN Rj45 per collegamento TCP/IP a web server.

230 Vca 50/60 Hz +10%
mn0ow

24 Vce (min 22Vcece + max 28Vcce)
0,3A

Temperatura: +5°C + +40°C / Umidita relativa: 25%-75% senza condensa
Diretto a rack 19” (2U).

482 x 88 x 220 mm
522 x 155 x 292 mm

4,5kg
5,5 kg

VAR 2006

230 Vca 50/60 Hz +10%
12w

24 Vce
0,5A

500 W
Temperatura: +5°C + +40°C / Umidita relativa: 25%-75% senza condensa
Diretto a rack 19” (1U).

482 x 44 x 220 mm
522 x 1565 x 292 mm

4 kg
5kg
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VAC 2006 VAR 2006

LISTA DELLE FUNZIONI OPZIONALI

Clausola Descrizione
7.6.2 Silenziamento manuale della condizione di allarme vocale
7.7.2 Reset manuale della condizione di allarme vocale
79 Uscita per segnalazione della condizione d’allarme vocale
8.3 Indicazione di guasto relativa ai percorsi di trasmissione
8.4 Indicazione di guasto relativa alle zone d’allarme
9 Disabillitazione dell’allarme vocale in determinate zone/a
10 Controllo manuale degli allarmi vocali
1" Interfaccia per dispositivi di controllo esterni
12 Microfono d’emergenza
13.14 Amplificatori di riserva
LISTA DELLE FUNZIONI AUSILIARIE
Chiamate broadcast
Musica di sottofondo
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Hudio

FST Contractor

€ X

code: 37782

Le informazioni contenute in questo manuale sono state scrupolosamente controllate; tuttavia non si assume nessuna
responsabilita per eventuali inesattezze. La FBT Elettronica S.p.A. si riserva il diritto di modificare le caratteristiche tecniche
ed estetiche dei prodotti in qualsiasi momento e senza preavviso.
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